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I ANTECEDENTES

1.1 EL RETO DE LA EDUCACIÓN SUPERIOR EN EL SIGLO XXI

"En los albores del nuevo siglo, se observa una demanda de educación superior sin
precedentes, acompañada de una gran diversificación de la misma, y una mayor toma de
conciencia de la importancia fundamental que este tipo de educación reviste para el
desa¡rollo sociocultural y económico y para la construcción del futuro, de cara al cual
las nuevas generlciones deberán estar preparadas con nuevas competencias y
nuevos conocimientos e ideales. La educación superior comprende todo tipo de
estudios de formación para la investigación en el nivel postsecundario, impartidos por
una universidad u otros establecimientos de enseñanza que estén acreditados por las
autoridades competentes del Estado como centros de enseñanza superior. L¡ educación
superior se enfrenta en todas partes ¡ desafios y dificultades rel¡tivos a la
linanciación, la igualdad de condiciones de acceso a los estudios y en el transcurso
de los mismos, una mejor capacitación del personal, la formación basada en las
competencias, la mejora y conservación de la c¡lidad de la enseñanza, la
investigación y los servicios, la pertinencia de los planes de estudios, las posibilidades
de empleo de los diplomados, el establecimiento de acuerdos de cooperación eficaces y
la igualdad de acceso a los beneficios que reporta la cooperación internacional. La
educación superior debe hacer frente a la vez ¡ los retos que suponen la¡ nuevas
oportunidades que abren las tecnologÍas, que mejoran l¡ m¡nera de producir,
organizar, difundir y controlar el ¡aber y de acceder al mismo. Deberá
garantizarse un acccso equitativo a estas tec[ologias en todos los niveles de los
sistem¡s de enseñanza.

[,a segunda mitad de nuestro siglo pasará a la historia de la educación superior como la
época de expansión más espectacular; a escala mundial, el nriL¡nero de estudiantes
matriculados se multiplicó por más de seis entre 1960 (13 millones) y 1995 (82
millonqs). Pero también es la época en que se ha agudizado aún más la disparidad,
que ya era enorme, entre los países industrialmente des¡rroll¡dos, los países en
desarrollo y en particular los países menos adelanfados en lo que respecta al ¡cceso
¡ la educ¡ción superior y la investigación y los recursos de que disponen. Ha sido
igualmente una época de mayor estratificación socioeconómica y de aumento de las
diferencias de oportunidades de enseñanza dentro de los propios países, incluso en
algunos de los más desarrollados y más ¡icos. Si carece de instituciones de educación
superior e investigación adecuadas que formen a una masa crítica de personas
cualificadas y cultas, ningún pais podrá garantizar rm auténtico desarrollo endógeno y
sostenible; los países en desarrollo y los países pobres, en particular, no podnín acortar
la distancia que los separa de los países desarrollados industrializados. El intercambio
de conocimientos, la cooperación intemacional y las nuevas tecnologías pueden
brind¡r nuevas oportunidades de reducir esta disparidad.

La educación superior ha dado sobradas pruebas de su viabilidad a lo largo de los siglos
y de su capacidad para transformarse y propiciar el cambio y el progreso de la sociedad.
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Dado el alcance y el ritmo de las transformaciones, la sociedad cada vez tiende más a
fundarse en el conocimiento, razón de que la educación superior y la investigación
formen hoy en día parte fundamental del desarrollo cultu¡al, socioeconómico y
ecológicamente sostenible de los individuos, las comunidades y las naciones. Por
consiguiente, y dado que tiene que hacer frente a imponentes desaflos, la propia
educación superior ha de emprender la transformación y la renovación m¿is radicales
que jamás haya tenido por delante, de forma que la sociedad contemporiínea, que en la
actualidad vive una profunda crisis de valores, pueda trascender las consideraciones
meramente económicas y asumir dimensiones de moralidad y espiritualidad más

arraigadas.

Subrayando que los sistemas de educación superior deberían: aumentar su
capacidad para vivir en medio de la incertidumbre, para transform¡rse y provocar el
cambio, para atender l¡s necesidades soci¡les y fomentar la solidaridad y la
igualdad; preservar y ejercer el rigor y la originalidad cientificos con espíritu imparcial
por ser un requisito previo decisivo para alcanzqr y mantener un nivel indispensable de
calidad; y colocar a los estudiantes en el primer plano de sus preocupaciones en la
perspectiva de una educación a lo largo de toda la vida a hn de que se puedan integrar
plenamente en la sociedad mundial del conocimiento del siglo que viene.

Artículo 7. Reforzar la cooperación con el mundo del trabajo y el análisis y la previsión
de las necesidades de la sociedad

a) En un contexto económico car¡cteriz¡do por los cembios y la aparición de
nuevos modelos de producción bas¡dos en el saber y sus aplicaciones, asl como en
el tratamiento de l¡ inform¡ción, deberían refo¡zarse y renovarse los vínculos
entre la enseñ¡nza superior, el mundo del trabaio y otros sectorca de h socied¡d.

b) Los vínculos con el mrmdo del trabajo pueden reforzarse mediante la participación de
sus representantes en los órganos rectores de las instituciones, la intensiñcación de la
utilización, por los docentes y los estudiantes, en los planos nacional e intemacional, de
las posibilidades de aprendizaje profesional y de combinación de estudios y trabajo, el
intercambio de personal entre el mundo del trabajo y las instituciones de educación
superior y la revisión de los planes de estudio prra quc se adapten mejor a las
pnf, cticas profesionales.

c) En su calidad de fuente permanente de formación, perfeccionamiento y reciclaje
profesionales, las instituciones de educación superior deberían tomar en
consider¡ción sistemátic¡mente l¡s tendencias que se dan en el mundo laboral y en
los sectores cientíñcos, tecnológicos y económicos. A frn de satisfacer las demandas
planteadas en el ¿irnbito del trabajo los sistemas de educación superior y el mundo del
trabajo deben crear y evaluar conjuntamente modalidades de aprendizaje, programas de
transición y progr¿¡mas de evaluación y reconocimiento previos de los conocimientos
adquiridos, que integren la teoría y la formación en el empleo. En el marco de su
función prospectiva, las instituciones de educación superior podrían contribuir a
foment¿¡ la creación de empleos, sin que éste sea el único fin en sí.

EDCOM Capltulo I - Ptúgha 2 ESPOL
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Artículo 8. La diversificacién
oportunidades

como medio de reforz¡r la igualdad de

a) La diversificación de los modelos de educación superior y de las modalidades y los
criterios de contratación es indispensable para responder a la tendencia intemacional de
masificación de la demanda y a la vez para dar acceso a distintos modos de enseñanza y
ampliar el acceso a grupos públicos cada vez más diversos, con miras a la educación a
lo largo de toda la vida, lo cual supone que se pueda ingresar en el sistema de educación
superior y sali¡ de él flicilmente.

b) Unos sistemas de educación superior más diversificados suponen nuevos tipos de
establecimientos de enseñanza postsecundaria, públicos, privados y no lucrativos, entre
otros. Esas instituciones deben ofrecer una amplia gama de posibilidades de
educ¡ción y formación: títulos tradicionales, cursillos, estudios a tiempo parcial,
horarios flexibles, cursos en módulos, enseñanza a distancia con ayuda, etc.

Afículo 9. Métodos educativos innovadores: pensamiento crítico y creatividad

a) En un mundo en rápido cambio, se percibe l¡ necesidad de una nueva visión y
un nuevo modelo de enseñanza superior, que debería estar centrado en el estudiante,
lo cual exige, en Ia mayor parte de los países, reformas en profundidad y una política
de ampliación del acceso, para acoger a categorlas de personas cad¡ vez más
diversas, así como una renovación de los contenidos, métodos, prácticas y medios
de transmisión del saber, que han de basarse en nuevos tipos de vínculos y de
colabo¡ación con la comunidad y con los mtás amplios sectores de la sociedad.

d) Los nuevos métodos pedagógicos también supondrán nuevos materiales didácticos.
Estos deber¿ín estar asociados a nuevos métodos de examen, que pongan a prueba no
sólo la memoria sino también las facultades de comprensión, la aptitud para las labores
prácticas y la creatividad.

Artículo 12. El potencial y los desafios de la tecnología

Los rápidos progresos de las nueyas tecnologías de l¡ información y la
comunicación seguirán modilic¡ndo la forma de elaboración, adquisición y
transmisión de los conocimientos. También es importante señalar que las nuevas
tecnologlas brindan posibilidades de renovar el contenido de los cursos y los métodos
pedagógicos, y de ampliar el acceso a la educación superior. No hay que olvidar, sin
embargo, que la nueva tecnología de la información no hace que los docentes dejen de
ser indispensables, sino que modifica su papel en relación con el proceso de
aprendizaje, y que el diálogo permanente que transforma la info¡mación en
conocimiento y comprensión pasa a ser fundamental. Los establecimientos de educación
superior han de dar el ejemplo en materia de aprovechamiento de las ventajas y el
potencial de las nuevas tecnologías de la información y la comunicación, velando por la
calidad y manteniendo niveles elevados en las prácticas y los resultados de la
educación, con un espíritu de apertur4 eqüdad y cooperación internacional, por los
siguientes medios:

a) constituir redes, realizar transferencias tecnológicas, formar recursos humanos,

EDCOM Copítulo I - Pdgina 3 ESPOL



elaborar material didáctico e intercambiar las experiencias de aplicación de estas
tecnologías a la enseñanza, la formación y la investigación, permitiendo así a todos el
acceso al saber;

b) crear nuevos entomos pedagógicos, que van desde los servicios de educ¡ción a
distanci¡ hasta los establecimientos y sistemas "virtuales" de enseñanz¡ superior,
capaces de salvar las distancias y establecer sistemas de educación de alta calidad,
favoreciendo así el progreso social y económico y la democratización así como otras
prioridades sociales importantes; empero, han de asegurarse de que el funcionamiento
de estos complejos educativos virtuales, creados a partir de redes regionales
continentales o globales, tenga lugar en un contexto respetuoso de las identidades
culturales y sociales;

c) aprovechar plenamente las fecnologías de la informacién y la comunicación con
fines educativos, esforzándose al mismo tiempo por corregir las graves desigualdades
existentes enke los países, asi como en el interior de éstos en lo que respecta al acceso a
las nuevas tecnologías de la información y la comunicación y a la producción de los
conespondientes recusos;

d) adaptar estas nuevas tecnologías ¡ las necesidades n¡cionales y locale§, velando
por que los sistemas técnicos, educativos, institucionales y de gestión las apoyen;

f) seguir de cerca la evolución de la sociedad del conocimiento a fin de garantizar el
mantenimiento de un nivel alto de calidad y de reglas de acceso equitativas;

g) teniendo en cuentas las nuevas posibilidades abiertas por el uso de las tecnologías de
la información y la comunicación, es importante observ que ante todo son los
establecimientos de educación superior los que utilizan esas tecnologias para
modemizar su trabajo en lugar de que éstas transforrnen a establecimientos feales en
entidades virtuales".
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2. SITUACIÓX ICTU¡,

2.I PRESENTACIÓN DEL PROYECTO

A la luz de los anteriores antecedentes queda claro que los retos del nuevo siglo
demandan que la universidad, como centro de distribución del conocimiento e

i¡formación de una sociedad, se renueve y actualice constantemente, tomando en cuenta
lo que exige el mercado laboral y el const¿nte avance tecnológico. La meta es lograr una
democratización del conocimiento mediante el libre flujo de información. Cómo
lograrlo es el reto. El presente proyecto se enmarca en esta visión y propone el uso de la
tecnología DVD como un medio idóneo tanto por los costos de reproducción como su
alcance social para transferir la información a un mayor número de individuos. En el
ma¡co de esta visión considera que el aspecto m¿is crítico en esta ecuación es la calidad
de Ia información que varnos a transferir. Para lograrla se propone someter a los
instructores al proceso más riguroso que existe en la actualidad para medir el
conocimiento y dominio de una determinada herramienta informática, la certificación.
El resultado sería la creación de cu¡sos semipresenciales en formato DVD para lograr el
dominio en una herramienta informática determiriada, que a su vez faculte al estudiante
para rendir el exiirnen de certificación en dicha aplicación. Efecto multiplicador.

2.2 DELIMITACIÓN

Por qué este tema?. Porque las tecnologías de comunicación han sido ampliamente 'rl

masificadas, como es el caso de los reproductores DVD, que por su bajo costo, son más
accesibles para la población que un ordenador personal.
Porque los medios para crear un producto audiovisual de este tipo permiten generar
material educativo de gran calidad con r¡n costo relativamente bajo.
Porque si seguimos los parámetros aconsejados en el presente p¡oyecto podremos
preservar la calidad de la educación en un nivel muy superior al que se obtendría en un
curso regular.
Porque es tiempo de diversificar la oferta educativa.
Porque esta experiencia abre el camino a nuevos métodos de educación en el área
informática de nuestra escuela como el uso de Intemet e intranets (SIB WEB).

2.3 MOTTVACIÓN

Si me preguntaran cómo me gustaría estudiar una determinada habilidad o técnica, sin
duda elegiría una que contenga material audiovisual como soporte. Si adicionalmente
este método es asequible económicamente y esti bien estructurado en lo pedagógico,
creo que puede ser de enorme beneficio para el estudiante. Una de mis preocupaciones
como docente es cómo mejorar el efecto multiplicador del conocimiento sin que en el
proceso se pierda la calidad de la misma. Una de la experiencias que he logrado
comprender es que el nivel del estudiante estri intrínsicamente ligado al nivel académico
de sus maestros. Un estudiante dificilmente podrá dominar una determinada herramienta
si su instructor tiene alguna deficiencia o desconocimiento de parte de la misma- El
problema se agrava cuando vemos cómo las herramientas de informática actuales
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globalizan su contenido de tal manera que pueda ser útiles para profesionales de una
misma rama pero con especialidades tan disímiles como un diseñador de paginas web,
un diagramador de revistas y periódicos, un editor de video o un ilustrador. Es
priácticamente imposible que un solo individuo domine todas estas técnicas, pero resulta
fundamental al momento de enseñar una determinada herramienta, pues se puede caer
en el er¡or de dirigir inconcientemente al esfudiante hacia una deterrninada especialidad
en det¡imento de otra,

Podemos constatar la objetividad de este planteamiento al observar que en el caso de las
herramientas de Adobe, el mayor fabricante de software para afistas y creativos del
mundo y, específicamente la aplicación que he tomado como piloto o prueba que es
Photoshop, que en el campo de la edición de imágenes domina el 94% del mercado
mundial, aún pese a ser segriLn estos datos una aplicación de extrema importancia para
los estudiantes y profesionales de diseño, vemos que no existe un solo ecuato¡iano que
haya obtenido el grado de certificación que demanda Adobe.

Si esto sucede con un prog¡ama que tiene una participación del 94 % del mercado de
aplicaciones para edición de imágenes y que pertenece a la mayor empresa fabricante de
software para artistas y creativos del mrmdo, como mínimo podremos inferir que existe
un problema que exige soluciones inmediatas.

EDCOM Capítulo2-Ptlgina2 ESPOL
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Diversificación de la oferta educativa post-secundaria.

Democratización educativa. Igualdad de condiciones de acceso a los estudios.

Contribuir al mejoramiento y conservación de la calidad de la enseñanza post-
secundaria.

Hacer uso adecuado de las nuevas tecnologías, que mejoran Ia manera de
producir, organizar, difundir y controlar el saber y la manera de acceder al
mismo.

Garantiza¡ un acceso equitativo a nuevas tecnologias en todos los niveles de los
sistemas de enseñanza

Renovar y reforzar los vínculos entre la enseñanza superior, el mundo del
trabajo y otros sectores de la sociedad.

Descentraliza¡ la oferta educativa.

La diversificación de la oferta educativa situaria a EDCOM como pionera en
nuestro medio en lo referente a usos de nuevas tecnologías aplicadas a la
educación.

El contenido del producto final, si bien en primera instancia está orientado a
reproducirse en formato DVD, puede ser migrado a otro tipo de tecnologías
como Intemet, generando nuevas oporturidades de negocio en este campo.

El contenido del producto final, si bien en primera instancia tiene ca¡ácter semi-
presencial, puede ser modificado como curso de autoaprendizaje sin necesidad
de tutor alguno, generando nuevas oportunidades de negocio en este campo.

. Esta metodología permite mantener el control de la calidad de la enseñanza
impartida.

. Ahorro de personal docente.

. Reducción de usos de laboratorios.

. Mayor cantidad de alumnos en un mismo periodo de tiempo.

EDCOM Capttalo 3 - Púgino I ESPOL
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3.1 VALIDEZ SOCIAL

3.2 VALIDEZ COMERCIAL

3.3 VALIDEZ ACADÉMICA
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4. PROPT]ESTA

4.I OBJETIVOS GENERALES

Establecer los lineamientos para la elaboración de cursos semipresenciales en formato
DYD para estudiantes que deseen prepararse para [a certificación en una aplicación
informática determinada, tomando como ejemplo el programa Adobe Photoshop.

4.2 OBJETIVOS ESPECIFICOS

O Documentar el proceso de creación de aplicativos educativos semipresenciales
en formato D\¡D.

O Establecer los requerimientos humanos y tecnológicos que intervendrían en el
pfoceso

O Desarrollar un piloto del aplicativo educativo semipresencial en formato DVD
de la herramienia Adobe Photoshop. r.lj."'' ,:l.:'r".. - ¡r

4.3 MARCOCONCETTUAI,

4.3.1 CONCEPTO

Con la finalidad de preparar al estudiante para rendir el examen de certificación en la
herramienta informática que desee, el presente proyecto propone elaborar cursos
semipresenciales en formato DVD para el aprendizaje de dicha herramienta, cuyo
contenido se ajustará a lo requerido por la empresa fabricante del software para pasar la
prueba de certificación.

Educativo

4.3.3 DESCRIPCIÓN DEL TRATAMIENTO O TÉCNICAS A UTILIZARSE

Captura en video de la pantalla de la computadora con software especializado
Grabación de audio. Autoría en DVD.

i. i- I <, :lsg

fÁ,,#
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Cada estudia¡te recibirá un DVD de entrenamiento semanal de la herramienta que desee
prepararsg con una duración aproximada de 4 horas, e[ cual deberá repasar. Al final de
la semana, el estudiante debe asistir a una clase presencial de dos horas donde recibirá
respuesta a sus interrogantes y en la cual debe rendir una prueba para medir sus
avances. Concluido el mismo se procede a la entrega del material didáctico para la
siguiente semana y así sucesivamente hasta terminar el entrenamiento, donde rendirá
una prueba final similar a la que le espenr en el proceso de certificación (Anexo 2).

4.3.2 GENERO
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4.3.4 DURACIÓN

20 horas de contenido en DVD

4.3.5 FRECUENCIA

2 horas presénciales + 4 horas de entrenamiento en DVD por semana, durante 5
semanas para cubrir todo el programa.

Esta carga horaria ha sido elaborada considerando una hora de estudios diaria" que a su

vez se traducirian en dos o tres horas con el respectivo repaso y revisión. Es de recalcar
que el estudiante que ingrese a este plan de estudios debe ser constante en el avance del
mismo, asumiendo su responsabilidad en el cumplimiento del cronograma establecido.
El profesor tutor üene como función verificar y estimular al estudiante en este aspecto.

4.3.6 MEDIO DE DIFUSIÓN

Reproductor de DVD tanto para computadoras como televisiones estándar 64Ox480 px

4.3.7 GRUPO OBJETIVO

EDCOM Capítulo 4 - Ptigino 2 ESPOT,

Para e[ presente tópico, que toma como ejemplo las aplicaciones de Adobe y
especificamente el programa Adobe Photoshop, el grupo objetivo estaria formado por:

. Alumnos regulares de la carrera de Diseño Gráfico de la Espol (grupo principal)

. Alumnos regulares de carreras afines con el diseño y la publicidad de otras
universidades.

. Profesionales del medio.

. Público con interés en mej orar sus habilidades en los productos de Adobe.
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5. ANÁLISIS Y COMPARACIÓN DEL PRODUCTO CON
PROPUESTAS SIMILARES A NTVEL LOCAL E
INTERNACIONAL

El uso de la tecnología DVD como medio educativo, se lo puede dividir en dos grupos:

a) Material educativo en formato DVD para ser reproducido por una computadora
b) Material educativo en formato DVD para ser reproducido tanto en computadoras

como en DVD Players para televisión.

Elegir el formato adecuado depende tanto del público objetivo como del propósito
general del proyecto. La diferencia principal entre estos dos métodos de reproducción
radica en la resolución máxima de la pantalla sobre la cual se va a captuftir el material
desde la computadora. Para los casos de DVD's que van a ser reproducidos
exclusivamente en computadoras el límite de esta resolución depende de la tarjeta
gráfica del equipo de trabajo, aunque se recomienda un m¡iximo de 1024 x 768 px para
mejor compatibilidad con la mayoría de monitores actuales. Para la captura de material
educativo cuyo destino es ser visto en un televisor, la resolución de pantalla máximo
podrá ser de 64Ox480 px, por cuanto es el tamaño eslindar para televisión.
Las ventajas y desventajas de estos dos métodos de reproducción deben ir de la mano
con el propósito general del proyecto como ya se ha mencionado. Si el material
educativo va a ser distribuido a un gtupo de usuarios que tienen acceso a computadoras
con reproductor de DVD incluido, el formato más adecuado seria el primero, por cuanto
la imagen capturada es mayor. Su desventaja es que no podrá ser reproducida en
televisores convencionales. Si el material educativo va a ser dist¡ibuido a un grupo de
usuarios que en un número considerable no disponen de acceso a una computadora, el
formato ideal sería el segundo, pues pueden revisar el material desde sus propios
televisores con la ayuda de cualquier reproductor de DVD's. Las desventajas de este
método es que se trabaja con resoluciones mucho menoresr que en el caso de ser
reproducidas en una computadora la imagen se auto ajustaní resultando en una imagen
mris pobre de la que se puede lograr con formatos exclusivamente para computadoras.

En el mercado actual el método más utilizado para material educativo relacionado con
aplicaciones informáticas es el primero, citando como ejemplos los siguientes tít¡fos:

DIGITAL MEDIA TRAINING SERIES
www.digitalmediatraining.com/

Empresa que desarrolla material educativo para Diseño Gráfico y Producción
Audiovisual, entre los que dest¿camos:

APPLE
DVD Studio Pro 4
DVD StudioPro 3
FCE HD 3.5 *new

Final Cut Express 2
Final Cut Pro - Field

EDCOM Capltuto 5 - Página I ESPOL
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Final Cut Pro 5
Final Cut Pro HD/4.5
Final Cut Studio
GarageBand
ilife '06 *new

il-ife'04
iWork '06 *new

iWork'05
Keynote 2
Logic Pro 7.1
Motion 2
Motion
OS X: Panther
OS X: Tiger
Pages

Production Suite
Soundt¡ack Pro

ADOBE
Acrobat 7
After Effects 7 *new

After Effects 6
Creative Suite 2
Creative Suite
Design Bundle *new

Encore DVD
Flash 8 *new

Golive CS2
Golive CS
Illustrator CS2 +new

Illustrator CS
InDesign CS2
InDesign CS
Photoshop CS2 *new

Photoshop CS
Premiere Pro 2 +new

Premiere Pro
Production Studio*new
Video Bundle *new

Video Collection

En el segundo grupo encontramos de igual manera una variada oferta de material
educativo para propósitos tan variados como "las Clases del Barca", curso en DVD para
aprender técnicas de futbol (distribuido por Diario El Universo en Ecuador), Cursos
para aprender a tocar algún instrumento musical
(www.musicroom.com/se/[D_No/025938/details.html). Debido a que el contenido de
este tipo de material no requiere el uso de computadoras, obviarnente lo hace idóneo
para su reproducción en lelevisión.

EDCOM Capttulo 5 - Págtna 2 ESPOL



Manud de P¡oduceión Audiovisual P¡oceso de Elabo¡ación de Cu¡sos Semiotesenciales

Pero, en este grupo también encontramos material de entrenamiento en aplicaciones
informáticas, cuyo máximo ejemplo son los programas que ofrece Total Training
(www.totaltraining.com), cuya calidad es tal que inclusive es recomendado desde la
propia página web de Adobe www.adobe.

Para el presente proyecto se ha considerado los dos tipos de captua y reproducción
disponibles, analizados sus pro y contras, concluyendo que el método más idóneo para
acceder a un mayor grupo poblacional es el segundo, es decir el curso que propone este
proyecto ha de se¡ capaz de reproducirse tanto en computadoras como en televisores,
aliviando de alguna manera ia cantidad de horas que el estudiante deba recurrir a una
computadora, que en muchos casos, al no poseerla deben alquilarla.

Son varias, entre las que se destacan:

Cunos Penonalizados
El presente proyecto propone crear una estructura metodológica acorde a nuestra
realidad.

Malerial Semioresencial con diolona
El estudiante que termine satisfactoriamente el curso propuesto recibirá rm Certificado
avalado por Espol que reconozca su esfuerzo.

Tuto¡ disoonible
Los avances de los participantes senán monitoreados por un expefo en la materia, quien
a su vez dará respuesta a las dudas que se presenten en los mismos.

Material educativo de soporle
Si bien el soporte audiovisual es la clave en este proyecto, este no es el finico material
que el estudiante recibirri pues adicional se le asignanfur ejercicios relacionados con el
tema de estudio y material de evaluación para medir su progreso.

Posibilidad de acceder a un laborato¡io de comouladoras
Dependiendo de la disponibilidad y predisposición de la universidad, el presente
proyecto puede ampliar la gama de servicios a sus estudiantes ofreciendo un lugar
donde puedan realizar su ent¡enarniento.

En Esoañol
Este es uno de los factores clave en la presente propuesta pues de las ofertas existentes
en el mercado actual ninguna se dicta en idioma español.

Preoarar al estudiante oara su cerlificación
Este es el elemento diferenciador de la presente propuesta, pues de las ofe¡tas existentes
en el mercado actual, ninguna garanliza cubrir todo el contenido que faculta al
estudiante a rendir la prueba mráxima de conocimientos en la herramienta que estudia
como lo es Ia certificación oficial de la misma.

CapftuloS-Pdgina3 ESPOL

Diferenci¡s de la presente propuesta a ofert¡s similares existentes en el merc¡do.

EDCOM
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Exoe¡iencia
Los estudiantes que deseen acceder al plan de certificaciones podrrín recibir asesoria
directa del proceso de manos de un tutor que previamente pasó esta prueba.

Por último, vale resaltar que todos los ejemplos de productos citados anteriormente
corresponden a empresas internacionales, nacionalmente este sería el primer proyecto
de su tipo.

EDCOM Capttulo 5-Pógina4 ESPOL
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6. REQUERIMIENTOS OPERACIONALES E
INFRAESTRUCTURA

6.T REQUERIMIENTOS DE HARDWARE

Para desarrollar la aplicación se sugieren los siguientes equipos de hardware:

Para ejecutar la aplicación se requieren los siguientes equipos

Cantidad Equipos

Xserve
DP/l GB/80GB/Combo/2rGigEfu nlimited

Xserve Raid 7x500GB Apple Drive
Modules 3.5 TB

Qlogic SANbox Express 1400 Fibre
Channel

Apple Fibre Channel PCI Express Card

Estaciones Power Mac Dual Core 2

Apple Cinema Display (20" flat panel)

Licencias Xsan

Apple remote Desktop l0 client

Dac Video Converter

Disco duro externo firewire

Monitor Tv 2l"

Microfono corbalero

Audifonos

Mbox DigiDesign

Detalle

Control de Metadatos

Almacenamiento video

Switcher

Tarjetas de Fibra

Edición.Posrproducci ón

Visualización

Almacenamiento
Compartido

Administración Remota

Conversión de video

Transporte datos

Previsualización

Captura audio

Edición audio

Audio

I

I

I

I

I

I

2

I
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a) Computadora con cualquier sistema operativo gráflco con lector de DVD; ó,

b) Reproductor de DVD convencional conectado a un teleüsor estrindar.

5

5

5

6

I

I

ESPOL



Para desarrollar la aplicación se sugieren los siguientes programas:

La aplicación no requiere la instalación de ningún programa adicional para su ejecución.

Software de Entrenamiento en
Creative Suite

2 Capacitación

Aplicación basePhotoshop CS2I

Captura de interfaz en videoSnapz ProI

EDCOM Capilulo 6 - Página 2 ESPOI,

Cantidad

Final Cut Studio

After Effects

6.2 REQUERIMIENTOS DE SOFTWARf,
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6.3 EQrrrPO DE TRABAJO

6.3.1 GRUPODETRABAJO

I

Diseño e implementación del modelo de
negocio. Buscar financiamiento. Buscar
capacitación para el personal. Supervisión de
cada uno de los cursos a desarrollarse.

I Director

Guión del proyecto a su cargo. Definirá el
contenido de los mismos. Supervisará el avence
del mismo. Sená el responsable de la edición y
arrnado final.

I
Asistente de
Dirección

Conseguir los elementos y materiales que
requiera el Director para uso en el proyecto.
Edición y post-producción del audio y video
enhegado por los diseñadores.

I
Asistente de
Producción

Control de asuntos fmancieros y
administrativos. Reportani los avances del
proyecto en base al cronograma.

2

Asistir y aprobar la capacitación. Desarrollo del
guión de los capítulos que le sean asignados.
Capturar en video los capítulos asignados.
Editar y entregar en formato .avi o .mov los
capinrlos asignados. Voz en offde referencia.

1 Sonidista
Grabar en offel guión. Sonorizar el fondo de la
aplicación.

I Locutor Voz en off

a 
^ 

R(i()( .,.\ N r'. Ft \('to\
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Jefe de proyecto

Diseñadores
Gráficos
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6,3.2 ORGA¡{IGRAMA

6.4 PERFIL DE FL]NCIONES

6.4.T JtrFE DE PROYECTO

6.4.1.1 PROPOSITO GENERAL

Planear organizar, coordinar, dirigir, y controlar las actividades de administración y
producción de la empresa, para lograr la eficiencia miíxima en sus operaciones al llevar
a cabo las misiones que se le asignen,

6.4.I.2 PRINCIPALES DESAFIOS

- Incrementar la eficiencia de la organización mediante la optimización de los recursos
humanos, materiales, tecnológicos y financieros de que se dispone.

- Emplear métodos eficientes para el desarrollo de las actividades vinculadas a la
producción.

DIRECTOR

ASISTENTE DIRECTOR ASISf EtttTE PRODUCCTÓN

DG1 DG2 SONID!STA

TITIJLO DEL PUESTO: Jefe de Proyecto

OCUPATITE:

LOCALIZACION; Guayaquil

DPTOJDMSION: Administación

SUBORDINADA A:

FECHA: 20 dejunio 2005

PREPARADO PIOR: Hugo Robles

APROBADA POR:

Fi¡ma delTíular del

f im¡ del superior

EDCOM Capltalo6-PtÍghal ESPOL
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6.4.T3 PRINCIPALES AREAS DE RASPONSABILIDAD

6.4. t .4 TITMENSTOI\IES

Total de p€rsonas que dep€nde del puesto

/ Personal subordinado directo:

/ Personal subordinado indirecto:

6.4.1.5 AUTORIDAD PARA LA TOMA DE DECI§IONES

DECISIONES ESPERADAS RECOMENDACIONES ESPERADAS

Diseñar e implantar sistemas de
seguimiento y de control de

proyectos.

Promover, planear y coordinar
procesos de reflexión para detectar

areas de oportunidad.

Buscar capacitación para el personal Crear un rubm para capacitación del

. personal

I

6

Organizar y coordinax la participación de
grupos de trabajo en los procesos

Apoyar el proceso de planeación
estratégica de la organización a través de
la generación de modelos cualitativos y

cuantitativos-

I

Diseño e implementación de¡
modelo de negocio

Alcanzar las metas
minimizar los imprevistos

v Entrega de Manual de
Proyecto

Organizar y supervisar el
trabajo para entregar el
producto final-

Cubrir las expectativas de
los clientes.

Satisfbcción del cliente.

I

Rt \t I I \t,(, I t\ \t I \l,t ll \1,(l ll)l{\l\\ l)l \lll)lll t.l I lx:ll()

EDCOM ESPOL

- Estaf en alerta pafa con§ervar los recursos de la ernpresa y para pfoducir el máximo
volumen de resultados finales sin perdida de recursos ni tiempo.

I

Evaluar Ia viabilidad técnica
y económica de un proyecto.

Proyección del alcance de
los proyestos.

Aumento de rentabilidad.

Capllulo6-PtúghaS
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CoNTACTOS n¡.,(S rUrORr¡,NrrS NATURALEZA O PROPOSITO

Autoridades de Espol Entablar negociaciones.

CONOCIMIENTOS

Experiencia en área gníÍica
Sistemas informáticos y audiovisuales.
Gestión de negocios
Idioma inglés.

HABILTDADES

Buen comunicador
Toma de decisiones
Relaciones Interpersonales
Creativo en la solución de problemas.
Orientado a los retos.

ATRIBUTOS

Organizado
Responsable
Líder
Visionario
Comprometido
Disciplinado
Emprendedor.

NI\¡EL

M
M

NIVEL

NTYEL

A
A
A
A
A

A
A
A
A
A
A
A

nT
::J
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6.4.1.6 RELACIOTTES DE TRABAJO

6.4.I.7 RECURSOS DE COMPETENCIA PARA EL EJERCICIO DEL CARGO
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6.4.2 DIRECTOR

6.4.2.I PROPOSITO GENERAL

Guiar y coordinar todos los procesos creativos y logísticos del proyecto a su cargo

6.4.2.2 PRINCIPALESDESAFIO§

- Mantener el nivel de calidad establecido en el plan inicial

- Motivar a su grupo de trabajo

- Optimizar los recursos

6.4.2.3 PRINCIPALES AREAS DE RESPONSABTLIDAD

TITULO DEL PUESTO: Director

OCUPANTE:

LOCALIZACION: Guayaquil

DPTO./DMSION: Administración

SUBORDTNADAA:

FECHA: 20 dejunio 2005

PREPARADO POR: Hugo Robles

APROBADAPOR;

FiEna del Titular

l)[_sc RtP('to\ t)[1. Pt tas'ro

I
Cumplir con el guión a
su c¿¡rgo

Que el producto sea
el esperado

Entrega de
capítulos según el
organigrama

Cubrir las
expectativas de los

clientes.
Satisfacción del

cliente.

I
Edición y armado final

Producto
ser usado

listo para Navegando y
haciendo pruebas
de usabilidad del
producto

lrolt\t.\s t)ii \t1])lll l:l
t.(x;tro

Itl:st Lt \¡x) lrl\ \l
l.sl,l.la \lx)

t\tP()t.t I \\( t\ \( ( lo\¡_\
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Filma del superior

I

Organizar y supervisar
el trabajo pí¡ra entregar
el producto final.
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Total de personas que depende del puesto

r' Personal subordinado directo:

/ Personal subordinado indirecto:

2

4

DECISIONES ESPERADAS

Definir el contenido de los capíhrlos

Crear productos de gran nivel
grríLfico y de contenido.

Buscar capacitación para el personal

RECOMENDACIONES ESPERADAS

Organizar y coordinar la participación de
grupos de trabajo en los procesos

Mantener constante presión sobre el grupo
de trabajo.

Obligar al personal a su cargo a que se

capaciten

CONTACTOS IT,fTiS IMPORTANTES

Jefe de Proyecto

Asistente de Producción

NATURALEZA O PROPOSITO

Revisa¡ Avances.

Aspectos financieros

CONOCIMIENTOS

Experiencia en rírea gni.dica

Sistemas informáticos y audiovizuales.
Gestión de negocios
Idioma inglés.

NIVEL
A
M
M

EDCOM Copítulo6-PdginaS

6.4.2.5 AUTORIDAD PARA LA TOMA DE DECISIONES

6.4.2.6 RELACIONES DE TRABAJO

6.4.2.7 R"ECTJRSOS DE COMPETENCIA PARA EL EJERCICIO DEL CARGO

ESPOL
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HABILIDADES NIVEL

Buen comunicador
Toma de decisiones
Relaciones Interpersonales
Creativo en la solución de problema§.
Orientado a los retos.

ATRJBUTOS NT\¡EI,

Organizado
Responsable
Líde¡
Visionario
Comprometido
Disciplinado
Emprendedor.

6.4.3 ASISTENTE DE DIRECTOR

6.43.I PROPOSITO GENERAL

Coordintu y hacer cumplir los requerimientos del Director.

ó.43.2 PRINCIPALESDESAHO§

- Dar soporte a las decisiones del Director

- Contribuir en el proceso creativo

- Conseguir los materiales que requiera la producción

- Coordinar con el Asistente de Producción los nspectos económicos y logísticos.

A
A
A
A
A

A
A
A
A
A
A
A

TITULO DEL PUESTO: Asistente de Director

OCUPANTE:

LOCALIZACION: Guayaquil

DPTO./DwISION: A&rinistración

SUBORDINADA A:

Fimadel'Iitular del

Fima del superior

[)ESC trtPCr()\ l)tiL Pt tislo
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FECHA: 20 dejunio 2005

PREPARADO POR: Hugo Robles

APROBADA PIOR:
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6.4.3.3 PRINCIPALES AREAS DE RESPON§ABILIDAI)

6.43.4 DIMENSIONES

Total de personas que depende del puesto

/ Personal subordinado directo:

/ Personal subordinado indirecto:

0

4

6.4.3.5 AUTORIDAD PARA LA TOMA DE DECTSIONE§

DECISIONES ESPERADAS RECOMENDACIONES ESPERADAS

Entregar material de capínrlos
Seleccionar imiigenes o gnifrcos de alta

calidad acorde al capítulo

Entregar a tiempo los capítulos

Cumplir con el cronograma de
capacitación

Edición de capítulos

Capacitarse

ó.4.3.6 RELACIONES DE TRABAJO

CONTACTOS MAS IMPORTA¡ITES NATURALEZA O PROPOSITO

Revisar Avances-

Asistente de Producción

Diseñadores Coordinar entrega de material

I
Entregar material
solioitado

Producto completo Revisión de avances

I Edición de video Edición de alta calidad Revisión de cortes

I
Post-Producción Interfaz agradable e

intuitiva
Revisión de
interfaces

Rt st I | \tx) l.t\ \t
t 5t't lt \t)o

t oR\t \\ t)t \t1t)ltt I I

L(X,tto
t\ll¡t)t \\( t \
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6.43.7 RECI]RSOS DE COMPETENCIA PARA EL EJERCICIO DEL CARGO

CONOCTMIENTOS NIVEL

Experiencia en área griifica
Sistemas informáticos y audiovisuales.
Experiencia en edición de video

HABILIDADES

ATRIBUTOS

6.4.4 ASISTENTE DE PRODUCCIÓN

6.4.4.1 PROPOSITO GENERAL

Mantener los estados financieros del proyecto en regla.

A

M

NIVEL

NTVEL

A
A
A
A
A
A
A

TITUI,O DEL PUESTO: Asistente de Producción

OCUPANTE:

LOCALIZACION: Guayaquil

DPTO./DTVISION: Administración

SUBORDINADA A:

FECHA: 20 dejun¡o 2005

PREPARAIX) POR: Hugo Robles

APROBADA POR:

l. irma de! 'l itula¡ dcl

l)t:!'( ltll¡( lO\ I)Ll. I't IsT()
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Buen comunicador
Toma de decisiones
Relaciones Interpersonales
Creativo en la solución de problemas.
Orientado a los retos.

Organizado
Responsable
Líder
Visionario
Comprometido
Disciplinado
Emprendedor.

A
A
A
A
A
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P

- Facilita¡ el trámite financiero

- Reportar al Jefe de proyecto avances del mis¡no

- Conseguir los materiales que requiera la producción

- Coordina¡ con el Asistente de Director los aspectos logisticos

6.4.4.3 PRINCIPALES AREAS DE RESPONSABILIDAD

6.4.4.4 I'IMENSIONE§

Total de personas que depende del puesto

y' Personal subordinado directo:

/ Personal subordinado indirecto:

6.4.4.5 AUTORIDAD PARA LA TOMA DE DECISIONES

0

4

DECISIONES ESPERAI}AS

Mantener los estados financieros Controlar el gasto

Vigilar avance del proyecto

RECOMENDACIONES ESPERADAS

Presencia continua en la produccrón

Mantener el
presupuesto

Estado de
cuentas

I
Control de Gastos

Enüega del
materialI

Reporte de avance del
proyecto

Revisión periódica del
material

l{}_§t l.t.\lx) l.l\ \l
t.:§Pt:t¡ \tx)

l.()R\¡ r\ I)[ \I t't)t t¡
t:l t.(x;Ror( ( t()\ust\lPf)t¡t\\(tt
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CONTACTOS MÁS TMTONT^C,NTNS

Jefe de Proyecto Revisar Avances.

Director Aspectos financieros

Asistente de Dirección Aspectos financieros

CONOCIMIENTOS

Experiencia en contabilidad
Sistemas ofimáticas

HABILIDADES

Buen comr¡nicador
Toma de decisiones
Relaciones Interpersonales
Lógico en la solución de problemas.
Orientado a los retos.

ATRIBUTOS

Organizado
Responsable
Líder
Visionario
Comprometido
Disciplinado
Emprendedor.

NIVEL

A

NryEL

NIYEL

A
A
A
A
A

A
A
A
A
A
A
A

EDCOM Capt alo 6 - Pttgiüa 13 ESPOL

6.4.4.6 RELACIONES DE TRABAJO

NATURALEZA O PROPOSITO

6.4.4.7 RECURSOS DE COMPETENCIA PARA EL EJERCICIO DEL CARGO



Manual de Producción Audiovisual de Elabo¡ación de Cu¡sos Semio¡esenciales

6.4.5 DTSEÑADOR GRTITICO

6.4.5.T PROPOSITO GENERAL

Desarrollar y elaborar el material asignado por el Director del Proyecto.

6.4.5.2 PRINCIPALES DESAFIOS

- Dar soporte a las decisiones del Director

- Contribuir en el proceso creativo

- Capturar video de capítulos asignados

6.4.5.3 PRINCIPALES AREAS DE RESPONSABILIDAI)

TITULO DEL PUESTO: Diseñador Gráfico

OCUPA.FITE:

LOCALIZACION: Guayaquil

DPTO./DMSION: Adminishación

SUBOR.DTNADA A:

FECHA: 20 d€junio 2005

PR-EPARADO POR: Hugo Robles

APROBADA PIOR:

¡'irma del Tilular del

Firm. del superior

1

Entregar material
solicitado

Producto completo Revisión de
avances

I Edición de video Edición de alta calidad Revisión de
cortes

t
Capacitación Material de alt¿ calidad Lecciones

periódicas

Rt.\t I I \tx) t;t\ \t
t'\Pt R \ t)()

t.oR\t \\ t)t. \ll t)llt
II I fr(;R{r

t\ 'ol \\( l \ \( ( t()\ Ls

EDCOM

t)lrs( RIPCI()\ t)t.-L Pt EST()

Capttulo 6 - PtúLgha 11 ESPOL
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Total de personas que depende del puesto

/ Personal subordinado directo:

r' Personal subordinado indirecto:

0

Entregar material de capítulos

Capacitarse

RECOMENDACIONES ESPERADA§

Diseñar contenido de capítulos de alto nivel
técnico

Cumplir con el cronograma de
capacitación

Director

Sonidista

NATURALEZA OPROPOSITO

Revisar y desarrollar guiones

Coordinación de materiales

CONOCIMIENTOS NT}'EL

Experiencia en iírea gnifica
Sistemas informáticos y audiovisuales.
Experiencia en edición de video

HABILIDADES

A
A
M

A
A
A
A
A

EDCOM Cap{tttlo6-Pdgtna15
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)

6.4.5.5 AUTORIDAD PARA LA TOMA DE DECISIONES

DECISIONES ESPERADAS

6.4.5.6 RELACIONES DE TRABAJO

CONTACTOS MÁS IMPORTANTES

6.4.5.7 RECURSOS DE COMPETENCIA PARA EL EJERCICIO DEI, CARGO

Buen comunicador
Toma de decisiones
Relaciones Inte¡personales
Creaüvo en la solución de problemas.
Orientado a los retos.
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ATRIBUTOS NIVEL

Organizado
Responsable
Visionario
Comprometido
Disciplinado
Emprendedor.

6.4.6 SONIDISTA

6.4.6.1 PROPO§ITO GE¡{ERAL

Desarrollar y elaborar el material de audio asignado por el Director del Proyecto.

A
A
A
A
A
A

TITULO DEL PUESTO; Sonidisa

OCUPANTE:

LOCALIZACION: Guayaquil

DPTO./DMSION; Administración

SU BORDINA.DA A:

FECHA: 20 de jtmio 2005

PR-EPARADO POR: Hugo Robles

APROBADA PIOR:

Finn¿ del Tituiar del

Fimra del ruper¡or

t)ES( I P(-ION DI.IL Pt lisl()

EDCOM ESPOL

6.4.6.2 PRINCIPA,LES DESAFIOS

- Dar soporte a las decisiones del Director

- Contribuir en el proceso c¡eativo

- Crea¡ audio de alta calidad

Capítulo ó- Prigha 16
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6.4.63 PRINCIPALES AREAS DE RESPONSABILIDAD

6.4.6.5 AUTORIDAD PARA LA TOMA DE DECISIONES

DECISIONES ESPERADAS

0

3

6.4.6.6 RELACIONES DE TRABAJO

CONTACTOS MAS IMPORTA}ITES

Director

Diseñadores

Locutor

RECOMENDACIONES ESPERADAS

Diseñar sonidos de fondo, musicalización y
voces de alto nivel técnico y artístico

Cumplir con el cronograma de
capacitación

NATURALEZA O PROPOSITO

Revisar y desarrollar guiones

Coordinación de materiales

G¡abar voz en off

Revisión de
avances

I
Entregar material
solicitado

Producto completo

Edición de alta calidad Revisión de
pistasI Edición de audio

I
Capacitación Material de alta calidad Lecciones

periódicas

tal :\t t. t \l)o I l\ \t
I \Pl ll \lx)

t.oll\t \s t)t_ \tf:t)tR
t:t . l (x; t{f)\( ( to\ t.s
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6.4.6,4 DIMENSTONES

Total de personas que depsnde del puesto

y' Personal subordinado directo:

/ Personal subordinado indirecto:

Entregar material de capítulos

Capacitarse

t\ ,r)R | \\( l\

ESPOL
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CONOCIMIENTOS

Experiencia en étrea gráfica
Sistemas informáticos y audiovisuales.
Experiencia en edición de audio
Fundamentos de Composición musical

HABILIDADES NIVEL

Buen comunicador
Toma de decisiones
Relaciones Interpersonales
Creativo en la solución de problemas.
Orientado a los retos.

ATRIBUTOS NIVEL

Organizado
Responsable
Visionario
Comprometido
Disciplinado
Emprendedor.

NIVEL
A
A

A
A
A
A
A

A
A
A
A
A
A

EDCOM Cap{tulo 6 - Página 18 ESPOL

6.4.6.7 RECURSOS DE COMPETENCIA PARA EL EJERCICIO DEL CARGO
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7. COSTOS Y PRESUPUESTOS

7.1 PRESUPUESTO DE OPERACTÓN

En el presupuesto aquí definido se establecen costos referenciales respecto a
los requerimientos de equipo humano, hardware y software necesarios para
el desarrollo del material completo del curso a realizarse, en este caso la
aplicación Adobe Photoshop.

PRESUPUESTO DE OPERACIÓN

TOTAL
PROYECTO

(Anual)
PERSONAL ADM.
jefe de Proyecto

Director

Asistente del Director

Asistente de Producción

Discñador Gráfioo

Sonidista

Locutor

1500

800

550

550

550

400

700

1 Mensual

I Mensual

I Mensual

I Mensual

2 Mensual

I Mensual

I Por
Proyecto

I Mensual

r 500

800

550

550

550

400

700

I 8000

9600

6600

6600

I 3200

4800

700

Secretaria

COSTOS ADM.
Útiles de oficina

T{}TAL

300 300

200

3600

I Mensual 2400

us $ 61900

EDCOM ESPOL

CANT. UNIDAD MENSUALDESCRIPCIÓN cosTo
UNIT.
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I

$ 8500.00$ 8500.00Xserve Raid 7x500GB Apple Drive
Modules 3,5 TB

I

Apple Fibre Channel PCI Express Card s 600.00 $ 3000.00

Apple Cinema Display (20" flat panel) $ 800.00 $ 4000.00

Apple remote Desktop l0 client $ 300.00 $ 300.00

Disco duro extemo firewire $ 180.00 $ 180.00

T
Micrófono corbatero $ 200.00 $ 200.00

Mbox DigiDesign $ 4s0.00 $ 450.00

$ 35510.00TOTAL

EDCOM Capítulo7 - Pttgina 2 ESPOL

7.2 PRESUPUESTO DE COSTO DE LOS EQUIPOS

CANTIDAD EQUIPOS SUB-TOTAL
PRECIO

UNITANO

Xserve $ 3000.00 $ 3000.00

$ 2000.00 $ 2000.00

I

5

5

5

6

I

2
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Software de Entrenamiento en
Creative Suite

s 250.002

I Photoshop CS2 $ 4s0.00

$ 80.00I Snapz Pro

TOTAL

EDCOM CapttutoT - Ptigiru 3 ESPOL

7.3 REQUERIMIENTOS DE SOFTWARE

SUBTOTAL

$ 500.00

$ 200.00

$ 450.00

$ 1299.00

$ 80.00

$ 999.00

$ 3528.00
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8. DESCRIPCIÓN DEL PROCESO DE PRODUCCIÓN

s.l CAPACITACIÓN

El primer paso para la elaboración del presente proyecto es la capacitación del elemento
humano que ha de intervenir en el diseño y estructuración de la metodología de
estudios. Los integrantes debenín pasar el proceso de certificación requerido por Adobe,
para lo cual se contempla un período de 3 meses para lograr este objetivo.

8.1.1 DISEÑO METODOLÓGICO DEL MATERIAL EDUCATIVO

El director del proyecto, tomando como base el contenido de temas que sugiere Adobe
(Anexo 2) para prepararse para la certificación ha de elaborar un guión para cada
capítulo del material educativo. El asistente del director se encargará de gestionar y
supervisar a los diseñado¡es para que provean el material que se requiera para que el
guión se lleve a efecto, por ejemplo, las imágenes que el director sugiera para un
determinado tema han de ser suministradas por el asistente o en su defecto colaborar
con el resto de diseñadores para que las consigan. Adicional al guión que elabore el
director para cada capítulo, éste se encargani de estructurar el contenido del material de
apoyo, como ejercicios de refuerzo y lecciones de conhol. Este material sená entregado
a uno de los diseñadores para que diagrame el conespondiente material y lo prepare
para su posterior impresión o reproducción (en caso de ser material digital).

8.I.2 PRODUCCIÓN

Una vez que el director haya elaborado el guión correspondiente a r¡n tema o capítulo en
particular, el asistente se encargará de preparar y entregar el texto al locutor para que
junto al sonidista se encarguen de grabar la voz en off. Con la voz en off sirviendo de
guia, los diseñadores procedenín a capturar la interfaz de la aplicación utilizando el
programa correspondiente. Este material capturado, junto con el archivo de audio
editado será entregado al asistente del director que se encargará de unir el contenido y
prepararlo para su exportación a la aplicación de autoría correspondiente.

8.I.3 POST-PRODUCCIÓN

Adicional a la edición del video capturado, es tarea del asistente del director y bajo
supervisión del mismo, diseñar la interfaz gráfica y programar la navegación del
multimedia audiovisual, así como añadir mehaje adicional al material educativo para su
mejor comprensión.

EDCOM Capltalo I - Página I ESPOL

Adicional a la grabación de la voz en off, es tarea del sonidista crear las pistas de audio
que servinin de fondo, así como efectos de sonido que requiera la producción.
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Una vez que el material educativo ha sido editado y post-producido, el asistente del
director se encargará de armar dicho material en la aplicación de auto¡ía
correspondiente y entregarle dicho material al director del proyecto, quien debe revisar
que la navegación y el contenido se ajusten a los parám€tros de calidad requeridos y
apruebe hnalmente la grabación de la copia maestra o copia cero, la cual estará lista
paü su posterior reproducción.

EDCOM Capllulo E - Ptigina 2 ESPOL
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9. CONCLUSIONES Y RECOMENDACIONES

9.I CONCLUSIONES

Se estima que anualmente se gradúan alrededor de 5000 nuevos diseñadores gráficos en
Ecuador, tomando de referencia que esta explosiva demanda educativa lleva alrededor
de I0 años, estamos hablando de un mercado objetivo de aproximadamente 50000
usuarios. A esto se debe agregar el interés que determinadas herramientas informáticas
para diseño despiertan en cÍrreras con propósitos similares. De este gran universo de
graduados, ninguno posee el titulo de certificación oficial. La principal causa de esta
acefalia es definitivamente la ausencia de un plan de estudios que les permita
capacitarse adecuadamente y tom€n el desafió de la certificación. Más allá de la
viabilidad económic4 que en una siguiente fase puede ser expandida a toda América
Latina, está el compromiso con nuestros egresados, de brinda¡les nuevas y mejores
oportunidades de capacitación continua para que a su vez reactiven con su talento el
aparato productivo de nuestra nación. Hoy por hoy, el rol del diseñador sigue sin ser
considerado seriamente por empresarios y proveedores de servicios, por
desconocimiento o malas experiencias en el pasado. Una forma de mejorar
efectivamente esta realidad es entregando al mercado laboral, profesionales capacitados
y certificados.

EDCOM Capttulo 9 - Púgha I ESPOL
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TABLA DE ILUSTRACIONES

Ilustración l. Ventana de Inicio de Adobe Photoshop
Ilustración 2. Panel de Preferencias
llustración 3. Cambio de aplicación
Ilustración 4. Archivo de preferencias de Adobe Photoshop
Ilustración 5. Cuadro de configuración de color...
llustración 6. Paletas de Photoshop
llustración 7. Menú de Paletas......
Ilustración 8. Personalización de Paletas
Ilustración 9. Creación de grupos de paletas (paso l).........
Ilustración 10. Creación de grupos de paletas (paso 2).........
Ilustración I l. Paletas personalizadas

2

J

J
4
4
5

6
7
8

9

Ilustración 12. Menú de salida de la aplicación....................
I lustración I 3. Preferencias actuali2adas....................
Ilustración 14. Aplicación por default.....
Ilustración 15. Menú de preferencias general
Ilustración 16. Menú de nuevo archivo
Ilustración I 7. Cuadro de configuración de nuevo archivo
Ilustración 18. Ejemplo de configuración predeterminada
llustración 19. Opción para personalizar un nuevo documento
Ilustración 20. Guardar una conhguración personalizada (paso l)
Ilustración 2l . Guardar una configuración personalizada (paso 2)
Ilustración 22. Guarda¡ una configuración personalizada (paso 3)
Ilustración 23. Asignación de modo de color

10

il
t2
t2
l3
l3
t4
t4
l5
l5
l6
t6
17
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Se desarrollará I capítulo de la aplicación Adobe Photoshop CS a manera de ejemplo.

ah.brlror Rr. Edn rtu4. re. §.ko fnef vra Brrdú ¡t ¡p . ,r ; io doñ2o,r6 H tD '
j

. '',

,? {

É

AJ,'

llustración l. Vertrna de lnicio de Adobe Photoshop

Todo programa tiene su forma de interactuar con el usuario a través de lo que se

denomina su Interfaz de usua¡io o user interface.

Al cargar por primera vez una aplicación, en este caso Adobe Photoshop, su IU se carga
por "default", es decir, con los pariímetros asignados por Adobe. A partir del primer clic
que el usuario de en la aplicación, el sistema operativo empieza a registrar todos los
cambios que este ¡ealiza, Lo que se conoce como personalización. Todos estos cambios
el sistema operativo los almacena en la carpeta Usuario/librería/preferencias/. Esto con
el objetivo de mantener la interfaz del pro$ama listo como el usuario lo ha configurado.

E l** r..bú 
^r ^crúe!! b..e$r'rid§

b rrú\ rkb,r.od¡ )

ll ¡d'.,i.r r.d'nri- «r"rk)
e h*h! ft,' w,t¡'¡ ,ú.,,

! n,r ¡r'd frió' rú ú. &ñ.

E
E
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CONTEMDO DEL PILOTO

,-

Voz en OFF:

CAPITULO T. EL ÁREA DE TRABAJO (WORKSPACE)
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Ilustración 2. Panel de Preferencias

En el caso de que un usuario no se encuentre conforme con sus preferencias o si desea¡e
restaurar la aplicación a su default, el primer paso es verificar que el programa no esté
activo.

iI ¡¡oue Ptrotoshop cs se¡rings

Q com.adobe.Aft erEffe(ts.plist
Fl com,adobe,lllustrator.Dllst

Ilustreción 3. Cambio de apliceción

F

n'

E

_§

,

a
tr

t--

t

r.

En caso de no querer eliminar permanentemente las preferencias anteriores, basta con
moverlas de la carpeta preferencias a otra ubicación.

S!t<rcM

¡l r..a*..

fio*n.
h*.*-.-
I
6

-E
Adobe Phoroshop CS
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(oñ.¡dobe.¡«ob¡¡...¡d.r,pl¡rr
(om.¡dobe.Aft .rE'fe(rs.clirt
coñ,¡doba.rlrúrrf or.plBr
rcír.Ílo5..tlr@l||oooll¡
(onr.¡trlb.o!lasw.§n¡Pt,Pliil

.om,¡oor.¡crd¡M{oñ¡tor.olií

.úrí.¿ppl..AddressSoot.plirr
com.¿Dol.-¡lroon.¿dn¡ñ¡rrlty.Dl¡n

llustración 4, Archivo de preferencias de Adobe Photoshop

La próxima vez que abra la aplicación, ésta aparecerá con su IU por default.

ñn..!r.o FX. Edn rF.r. t¡r., s.ld tiri.r v¡., f/ña* kb a .r ll {r d.ñ ¿o:.r ¡ O '
tr',¡" '" -':: ?'

É

Ilustración 5. Cuadro de conligureción de color

Lo primero que nos pide el programa es configr¡rar r¡n perfrl de color para Photoshop,
tema que analizaremos más adelanle, por lo pronto de clic en la opción No.

Una vez dentro de la IU de Photoshop nos encontramos con las paletas de her¡'¿mientas.
Esta es la manera cómo el progftima pone a nuestra disposición todas sus herr¿mientas

+
c¿¡d ,ár'.¡ r' ?,6.l'1 (3 !¡ ¡. o¡.ñ,ri úhr ¿.É*I

-J
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N¡vi9¡tor

--:-\

*.l-
"-,.l-

l

D

rl

I cotor

fI--Tl

úTr-],I

Hirtory

P¡l htL¡yerr

JJ+9
Opaciw

ti )

llustración ó. Psletss de Pholoshop
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Window Help

Arrange
Workspace

Actions
Brushes
Channels
Character

r' Color
File Browser
Histogram

r' History
lnfo
Layer Comps

r' Layers
r' Nav¡gator
r' Options

Paragraph
Paths
Styles
Swatches
Tool Presets

r' Too¡s

\¡g
F5

F6

F8

F7

llustrsción 7. Menú de Paletas

Podemos activar o desactivar todas las paletas que deseemos, éstas se almacenan en el
Menú Windows. Basta dar un clic en la paleta deseada y esta aparece en la pantalla.
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Podemos formar grupos con ellas o separarlas
individualment
' i Plto¡o.ñoc Frl. Edn lm.q. urrr ir..r allt.r vi.r ffndor r¡19

___1

+
É--rr-

llustración E. P€rsonal¡zación de Pal€tas
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Ed¡r lñ!¡9. L¡ylr 5.1.(t Flher Vi.w W¡¡do* ¡t lp

llustración 9. Creación de grupos d. pslet¡s (p¡so 1)
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ftL Edir tm¿g€ L¡ylr Selaat Filtar M.lv Wiftlor H.lp

f!--J r 1 r.". :- .j

I 7

q
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\ T
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E- frEi-

fiE- rr.
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¡tt¡
¡¡

E

il

Ilustración 10. Creación de grupos de paletas (p¡so 2)

Una de las características más interesantes es la posibilidad de formar cadenas de
paletas. Solo tiene que arastrar una paleta hacia la parte inferior de otra, hasta que

aparezca un borde negro, lo que indica que podemos soltar la paleta.

;
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Ó Photoshop Select
Styf., ' ¡¡orn .f

F ile Ed it I mag e Laye r
Fe¿:-e r C a¡

llustración I l. Palct¡s personal¡zsd{s
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¡ File Edit lmage Layer

About Photoshop...
About PIug-ln

Color Settings...
Preferences

Servicios

Ocultar Photoshop
Ocultar otros

o*K

^*H
\XH

q.
Ilustración 12. Menú de salida de la aplicacióo

Sea cual fuere la forma cómo organiza sus herramientas, tenga la seguridad que la
próxima vez que abra la aplicación, la encontrará tal como la configuró, gracias al
registo de las preferencias de la aplicación por parte del sistema operativo.

d,'',r.
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llustración 13, Preferencias ¡ctualizedas

Layrr S€l.ct Filt€r View Window Help

rl

llustr¡ción 14. Aplicación por def¡ult
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Al momento de resetear las preferencias, la primera pantalla en aparecer es la de
bienvenida, en la que nos ofrece una serie de opciones tales como novedades de la
nueva versión y enlaces a sitios de Adobe para obtener miás información de la nueva
versión.

- File Edit lmage Layer Select F¡lter View

About Photoshop...
About Plug-ln

Color Settings...

Stylt: ¡lorrñ¡l It

o*K
Cene ral. .. XK

\.1 r.

File Handling...
Display & Cursors...
Transparency & Gamut...
Units & Rulers...
Guides, Grid & Slices...
Plug-lns & Scratch Disks.
Memory & lmage Cactre...
File 8rowser...

Ilustr¡ción 15. Menú de preferencias general

También podemos modifica¡ más opciones de la aplicación mediante el menú
Prefe¡ences situado debajo del botón de la aplicación.

ú Photoshop Ed¡t lmage Layer Sel

I

*o
oxo

Ilüstración 16. Menrl de nuevo archivo

Una vez ordenadas las paletas a nuestro gusto, procedemos a crear un nuevo documento
en donde realiza¡emos nuestro trabajo. Este documento dentro de photoshop recibe el
nombre de lienzo o cÍrnvas, en alusión al soporte que utilizan los artistas para crear sus
cuadros.

Para crear un nuevo lienzo, damos clic en la opción New del menú File

Open...
8rowse... ¡,F
r.llaa l.¡ Oaa6 rtl

Photoshop

?.
4

¿

!7

Ocultar Photoshop
Ocul¡ar otros
Mostrar todo

Salir de Photoshop XQ

Se ruicios

^*H
\*H

a.

Preferences

tr É¡ New... 8tN
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New

N¿me: unritled- 1

width:

Haight:

Resolution:

Color Mode:

Background Contents:

16,02

11,99

28,346

RGB Color l5l
p,xels/cm i t

8 b,t il
-;r

Delete Pr€set

lmage Size

452,2K

(m

cm

Whit€

Advanced

llustración 17. Cuadro de configuración de nuevo archivo

Aparece la ventana de configuración del lienzo. Aquí estableceremos el ancho y alto de
nuestro lienzo, su resolución, modo de color, unidad de medida y color de fondo

New

Ilustracién 18. Ejemplo de couligursciótr predetermin¡da

Cancel

Save Preset...

CancelPreset NTSC Dl 720 x 486 (with guides)

Save Preset

Oelete Preset

Dr/ov NTsc (0,9)

Advanced

^l

Name: Para tv

Height: 486 lsprxe

w¡dth: 720

--it

Eackqround Contents:

Working RCB: SRGB lEC6l

pixels

pixels/inch

I bir

lmage Size:

1,00M

Color Profile:

P¡xel Asp€ct Ratio:

EDCOM AnexoI-Págluall ESPOL

Preset: Custom

.l

Resolution: 172

Color Mode: ' RCB C.l*

Si lo prefiere puede elegir entre una vasta selección de lienzos predeterminados.



r
>e

eI
t Photoshop File

fa¡dlar: 0

Default Photoshop Size

Lette r

llustr¡ciér¡ 19. Opciótr para personalizar un nuevo documento

O elegir la opción Personalizado o Custom para crear un lienzo con sus propias
especificaciones.

Ó ¡toto¡troC Fll. Ed¡t lnragE L¡t r S.l.cr Fihrr Vi.rv Windoú H.lp

E.-J ¡ o tr -JI

Puede guardar su lienzo predeterminado para volver a usarlo a futuro. Sólo de clic en la
opción Save Preset una vez configurados todos los campos. Agregue un nombre
relacionado con el lienzo que acaba de crear y listo. Este nuevo lienzo predeterminado
por usted estará disponible a partir de ahora en el menú de opciones predeterminadas.

li

-l ,1,
'.'t q

H
))

f r-l
ftt{

\

?
tf

T lave P.".pt...

.'
t

H!i9ht: 1111

1111

pxe! a

8a(kground Cont.rB: lm¡gr S¡z€:

I,SIM

coto¡ no¿c: 
, 
rcs color l¡l
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OK

Preset: Custom
-;r

width: 1l 11 pixels

Height: 1111 pixelg Delete Preset

Resolution: 72 pixels/¡n(h

New Do(ument Preset

Eackg

llustración 21. Guardar una conliguración pemonalizada (paso 2)

'!

Preset:

Custom

Clipbo¿rd

O€fault Photoshop S¡ze

Letter
Legal
Tabloid

OK

Sav€ Preset

Backg lmag€ Size:

3,51M

640 x 480
800 x 600
1024 x 768

NTSC DV 72O x 48O (with guides)

tlustración 22. Guardar una conliguración person¡l¡z¡da (paso 3)

Debajo de esta venta, apruece la opción Avarzada que permite seleccionar el tipo de
perfil de color con el que trabajará en Photoshop, tema que trataremos en siguientes
capítulos. Por ahora de clic en Ok y empecemos a revisax esta poderosa herramienta de
edición de imágenes.

2x3
4x6
5x7
8x l0

Save Preset,,.

Cancel

lnclude ln Saved Senings:

Sl Resolution ff cont"nt
El uo¿" f rronte
Ela¡t oepttr g Pixel Aspect Ratio

I Values not ¡n(luded in the saved preset
: - w¡ll default to their last used value.

Preset Name: pedeñnido 1

Cancel

Delete Preset...

t
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Name Para w OK

Preset: 640 x,180

width 640 pix.ls
t

Height: 480

R4olution:72

8¡ck9 round Coñtents: white

pxes

o xe sr'¡<l' I

lm¡g. Size

900,0(
Adv¿n.ed

Color Proñ1.:

Pixel Arp.ct Rat¡o: Adobe RCB (1998)
Apple RCB

ColorMat(h RCB

sRGB 1EC61956-2.1

Appl. Studio Dirpl¡y
Apph Srudio ¡C/Tv
CIE RG¡
c-§RGB
Clnaric Monhoa
Gtúcric RCS Proñlc
H'5 pr
H'r p.lnt
h'3 t!,
Bs Pro
|fr ProPr¡nt
tl! Prlñt
KOOAI Grmric DCS C¡mcr¡ lnpst
tlkrotlk 600Z§
Niton 6-3510 AF
¡nsc (1953)

PAUSECA
ProPhoto RGg

ROtill-RG8
§ PTE.C
slCB ProñL
lVidr G¡i!út RCg

Ilustración 23. Asignación de modo de color

nCBr rRCB 1EC61965-2.1

EDCOM An*oI-PtúginaIT
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/t\ CERTIFIED EXPERT
Adobe

EXAM PREPARATION GUIDE

Adobe'Photoshop

This guide provides all the informat¡on you need to get started ¡n
preparing for Adobe Certified Expert (ACE) and recertiñcation exams.
Passing ACE and recertification exams demonstrates your proficiency
with Adobe software products and allows you to promote your
expertise with customers and employers. As an ACE, you can stand out
from your compet¡tors and be noticed,

ACE fr.qu.ntly Ask d Qu6tlons
What ¡5 an ACE?What are the beneñts ofbe¡ng cert¡ñed? Whatare the exams
l¡ke? Get allyour ACE quest¡ons answered ¡n a brief,ro-th€-point FAQ,

Foür-St p ChC* L¡st

Learn about the pro<ess for getting certlfied,

Step 1: Choos€ your cert¡ñcat¡on level.

Step 2: Reg¡ster foryou. exam(s).

Step 3r Prepare for and take yourexam(s).

step 4: Read the ACE Agreement and Jo¡n the Adobe Certiñed commun¡ty.

Ex.m Toplc Arra¡ and Obr.(lv.i
R€view the test coffent-topic areas and obj€ct¡ve5-for each product exam.
The topic l¡sts w¡llhelp direct yourstud¡es, so please revlew correctly.

Pracü(a Exarns

Revlew sample quest¡ons to getan ¡dea ofthe types of qr¡estioñs that will
be on the exam. Jvofe : Though helpful, these practice exomt ore not necessorily

rc$esentotive ol the d¡fñaulay of the quest¡ons that you wlll encwntet on the
octudlexom.

Pract¡ce exams are ¡ya¡l¿ble fof all of the followlng Adobe products

. Adob€ Acrobat ó.o Prof$sional

. Adobe Acrobat 7.o Professional
- Print Production
- wlth Adobe Llvecycle" Deslgner

. Adobe After Efrects' 6.0 Professi¡,nal
, Adobe Gollv€' CS

. Adobe Gouve CS2

. Adobe lllustrator'CS

' Adobe lllustrator CS2
. Adobe lnD€slgn'CS
. Adobe lnDesign CS2
. Adobe Photoshop'CS
. Adobe PhoroshopCS2

' Adobe Premiere' Pro

cs2
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a.
A.

CERTIFIED EXPERT

Wh.t is .n Adob. Ccrtlfird 6rD.rt (ACE)?

An Adobe Certiñed Expen (ACE) hasearned a certiñcation created spec¡fically
for graph¡c des¡gners, Web designers, video professlonals, system ¡ntegrators,

value-added resellers, developers, or busine6s professionals seeking recognition
forthe¡r expertise with Adobe products. By pássing one or more ACE exams, you

become el¡gibleto promote yourself to prospect¡ve d¡ents as a highly sk¡lled,
expenJevel user of Adobe software,

FNEQUENTLY ASKED

ol.¡¡sno¡¡s

Q. What ls th. maln bcn€ñt ot passlng ACE.xams rnd bé(omlng Adobe
c€rtiñod?

A. Adobe cenificat¡on is an industry standard in excellence that can be used

to demonstrate your product knowledge and expeniseand also serves as a

catalyst when ñnding ajob or seeking a promot¡on, The Adobe Certiñed Expert
(ACE) and Adobe Cert¡ñed lnstructor(ACl) logos and credentials have been

created for self-promot¡onal use by individuals who haw met allrequirements of
the Adobe Cert¡fied Expert orAdobe Certiñed lnstructor programs.Those who
have passed the te5ts may place certifrc¿tion logos on bus¡ness cards, resumés,

Web s¡tes, and othef promotional materials,

Q. WhEt.rc ACE Sp.clillst rnd ACE Martcr?

A. There are three levels ofAdobe cert¡6cat¡on.

1. Single product cen¡ñcat¡on: Recogn¡zes your proficiency ¡n a 5ingle Adobe
product. To qual¡fy as an ACE, you must pass one product-spec¡ñc exam.
Example:ACE, Adobe l¡Design CS2

2, Spec¡al¡st certlfication: Recogn¡zes your profciency ¡n a spec¡ñc medium:
Print, Web or Video.To become certified as a Specialist, you must pass the
exams on the requ¡red products listed below. Example: ACE Print spe(lallst
(w¡th passing marks on the tests for Adobe lnDes¡gn, Adobe AcrobaL and
either Adobe Photoshop or Adobe lllustr¿tor)

Speclal¡sts must pass all requ¡red (R) exams añd ariy one elect¡ve (E) w¡th¡n any
g¡ven certiñcat¡on track:

Adoba lnDc!lgn

Adobe GoLlve

Adobe A(]ob¡t*
Adobc Photoihop

Adob. lllustrator

Adob€ Premlere

Adobe Aft.r Effc<ts

Frlnt Spoclallst

R

R

E

E

Web Speclalist

R

E

R

E

Vldeo Specl¿ll5t

R

R

R

Note: Exam requir€ments are subject to change.
*Adobe A(robat 7.o Professional Print Product¡on exam only.

/r\'
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ADOBE CERTIFIED EXPERT

Master cert¡6cat¡oni Recognizes yoursk¡lls ¡n terms ofhowtheyalign w¡th
the Adobe product suites. To become cert¡fied as a Master, you must pass

theexam for ea(h ofthe products in the suite. Example: ACE, Creative Suite
Master(wlth passing marks on the tests for Adobe Acrobat, Adobe Gol¡ve,
Adobe lllustrator, Adob€ lnDes¡gn, and Adobe Photoshop)

Q. Whlt 15 an Adobo C.rtlf,.d lnrtructor (ACl)?

A. An Adobe Certiñed Instructor (ACl) ¡5 an ACE who prov¡des ¡nstruct¡on on
Adobe products. ACls must havean ¡nstructor qualifrcation (a teaching
credent¡al, passed theCompTlA CfT+ (http:/ ,vww.comptia.orglcertiñcation/
ctt, or equ¡valent), ln addit¡on to pa5s¡ng one or more ACE exams. For more

¡nfomation, vis¡t the ACI home page, http'//www.¿dobe.coñ/support/
cenificat¡on/aci.html

Q. How do I prapar. for .n ACE Ex.m?

A. The keys to preparing for an ACE exam are exper¡ence with the product and

studying this Exam Preparation Gu¡de (http//panneB.adobe.com/public/
acelma¡n.html), To access onlinetralniñg, user guldes, and marry other 5tudy
mater¡als, vis¡t Adobe's training resources page (http://www.adobe.com/

support/training.html), The following resources mayalso help you prepare for
your ACE exam:

. Adobe product user guides

. Adob€ Press books

Adobe Authorized Training Centers (find the AATC nearestyou through
the Adobe Partner Finde¡ online at: http://partners.adobe.com/asn/
pa rtnerñnder/search_tra¡nin9 jsp)

Adobe onl¡ne training at www.adobe.elementk.com

Tutorials and mater¡als from Total fr¿inlng, at www.totaltra¡ning.com

Other training resources onl¡ne at www.adobe.com/5uppon/tra¡n¡ng.html

Q. How do l9.lt.rln¡ng?
A. Once you know what product you want to get cen¡fied ¡n, us€ the Adobe Partner

Finder (hnp://partners.adobe.com/asn/partnerfinder/tralningprovider/¡ndex.
jsp) database to locate an Adobe Cert¡fied lnstructor or an AdobeAuthorized
Train¡ng Center in yourarea thatteaches a class on the Adobe productyou want
to leam. Contact them directly for more ¡nformation about the¡r classes and
reglstration deta¡ls.

Q, Whlt ars th. bcnaftr to bc<omlng .n ACE?

A. As an lndiv¡dualw¡th an ACE, you can:
. D¡ñerent¡ate yourself from comp€titors
. Get your resumé notlced
. Attfact and win new business
. Galn fecognition fiom your employer
. Get the ¡nside track on Adobes latest offerings
. Leverage the power ofthe Adobe brand and resources

lfyou are¿o employer, use ACE as a benchmark 50 you can:
. Find the r¡ght p€rson forthejob
. Quickly assesscandidate skill level
. lnvest ¡n your most promising employees
. lncreaseproduct¡vityandefñcieñcy

3
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FqEQUENTLY AsKED

el¡rsnons

Pearson VUE Thomson Prometrlc

Registar onllno

Req¡ster in-peruon

www.pea6onvue.com

F¡nd a loca§on onl¡ne at
wv/w.peaIsonvue.com

www.2test.com

Find a locat¡on onl¡ne at
www.2test.com

ADOBE CERTIFIED EXPERT

Q. Whlt type of .x.m !r. thc ACE .xamJ?

A. Adobe ACE exams (whlch are administered by Pearson VUE and Thomson

Prometrlc ¡ndependent third-partytert¡n9 companies) are computer-deliveréd,
€losed-book tests conslst¡ng of60 to 90 muh¡ple-choice quest¡orLr. Each e)(am

tákes approximately one to two hours to complet€, and results are g¡ven to you

at thetest¡ng center ¡mmed¡ately after you compl€te the test.

Q. What type of axan rrc the rcc.rtiñcatlon exams?

A. Adobe recertification exams ¿re web adm¡n¡stered exams that are available to
curreñt ACE5 only- The exams are deli'¡ered to your desktop via the Web. The

tests consist of30-60 muhiple cho¡ce questions focusing exclu5ively on new
product features. Each exam takes approximately 30 minutes to on€ hour to
(omplete. Results are revealed ¡mmediately after you finish.

Q. How do I riglstrrforan ACE qxam?

A. Contact Pearson VUE orfhomson Prometric by phone, on the web, or in-personi

Q. Whrt ¡s the fc. for th. ACE .x¡m?
A. Each exam ¡s USs15o or lo(al currency equ¡valent.

Q, whrt ls th. f.. for th. r.c.rtl6cat¡on .xrm?
A. fhe fee fo¡ Web admlnistered ACE recenlfcat¡on exams ¡s US95o orlocal

cunency equivalent,

Q. Soon attCr I p¡stcd an ACE cx.m, ttc axám w.5 publlshcd 6r. ltaw
p.oductvsrslon. Do I h.veto su((cssfully complete tha naw exam wlthlir
90 d!Y¡?

A. You may continue to u5e the ACE logo and materials in accordance w¡th the
Adobe Certlñed Program Guldellnes for Logos and Credent¡als. When the ACE

and recert¡ficatlon exams are published for the next vers¡on of the product, you

must successfully complete that ex¿m with¡n 90 days to keep yourACE status
current and (ontinue uslng the ACE logo and mater¡alr.

Q. Whlt can lexpcct from Adob. if I p.r5 the ACE axrm?

A. A5 soon as you pass the exam, your name and exam resuhs are given to us by
Peafson VUE orThomson Prometric, our worldwide test admin¡strators, Your
exam data isthen entered ¡nto ourdatabase. You wlllthen be sentan ACE

Welcome Kit and access tothe ACE loqo. You are also placed on our cert¡ñcation
mailing l¡stto receive specialAdobe announcements and ¡nformation about
promot¡ons and events thattake place throughoutthe year.

Q. How long doei at t¡k to.c<Glva my Wokom. Xk?

A. You can expect your Wel€ome Kit to afr¡ve four to s¡x week aftef we receive
ygur exam resu¡ts.

/r\'
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ADOBE CERTIFIED EXPERT
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STEP 1 : choosc your cCrtlñcatlon laval

fhere are three levels ofcert¡ñcat¡on to become an Adobe'Cen¡fred Expert

Choose the one that's r¡ghtforyou.

Slngl€ produd certlñcit¡on: Recogn¡zes your proñcien<y in a slngleAdobe
produd.To quallfy ¡r an ACE, you must pass ono produd-spcdñc exrm.

Example: ACE, Adobe lnDesign" CS

Spadillst c€rtlñGatlon ! Recognizar your proficlancy ¡n r spc(lñ( mcdlum:
pfln! Wab, or úd.o. To bccome (oÉiñcd 13 a Spa<¡¡l¡3t, you must pú3 tha
crrms on thc r.qulréd productt llstGd bclow.

Example:ACE Pr¡nt Spec¡al¡st (w¡th passing mark on the tests for Adobe
lnDes¡gn, Adobe Acrobat, and eitherAdobe Photoshop or Adobe lllustrator)

M.ster c.rüñcrtlon3 Re<ogn¡zcs your skills in tCnff of how thcy align wlth
thcAdobo product suitca.To be(omc cartlfed as a ¡lrster, you mult pais
thc ex¡m for aach ofthe productr ¡ntha rulte.

Example: ACE, Creative Suite Master (with pass¡ng marks on the tests for
Adobe Acrobaq Adobe Golive, Adobe lllustrator, Adobe lnDes¡gn, and Adobe
Photoshop)

specialists must pass allrequ¡red (R) exams and any oneelective (E) within any
given certifi cation track:

Adobc lnDc¡¡9n

Adobc GoLlve

Adob€ Acrobat*

Adobs Photoshop

Adobc llluitr.tor
Adobé Premiera

Adobe Aft r Eff.cts

P"int Speclallst

R

R

E

E

Wob Spccl.lirt

R

E

R

E

R

R

R

Note: Exam requirements are subiect to change.
*Adobe Acrobat 7.o Profels¡onal Print Product¡on exam only.

SÍEP 2: Rcal3tqr fo, your .x¡m(sl
Adobe ACE exams are adm¡nlstered by Pearson VUE and Thomson Prometric,

indep€ndent th¡rd-party test¡ng compan¡es. fhe tests are offered at morethan
6ve thousand authorized testing centers ¡n many countries.

To regiter for youf ACE exam(s), contact Pearsgn VUE or fhomson Prometlc
by phone, on the Web, or ¡n person. Please note, all recertiñcat¡on web based
exams are del¡vered through Thomson Prometfic only.

FQUR-srEP

cllrEcK Lrsr

1

2

3

Pa.rson VUE

R.gist ronlln.
Re9¡rtcr ¡n-person

www.pearsonvue.com

F¡nda location onlirle at
www.peafsonvue.com

www.2test.com

F¡nd a loration onlifie at
www2test.com

Page 4 fhe ACE exam fee is USsiso worldwide. The recert¡fication exam fee ¡5 USS5o. ldoü.
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FOUR-5TEP

CHECK LIST

ADOBE CERTIFIED EXPERT

STEP 3¡ Prcprr. for ard t kr your.nm(¡)
The keys to prepar¡ñg foran ACE exam ¿re experiencewith the product and

studying ueing the Exam Pfep Gu¡de. To access online training, usergu¡des, and
many other study materlals, vls¡t Adobe's tra¡nin9 resources page.

Th€ following resources mayalso helpyou prepare for yourACEexam:

. Adobe product user guldes

. Adobe Press book5

. Adobe Authofized Tra¡n¡ng Centers (find the AATC nearest you th.ough the
online Adobe Partner F¡nder)

. Adobe online tra¡ning from Element K (http://adobe.elementk.com)

. Tutofials and materialsfrom Total Tra¡ning (http//www.totaltraining.com)

. Otheronline traln¡ng resources

ACE exams are computer-delivered, closed-book tests consisting of 60 to 90
multiple-choice questions. Each exam takes one totwo houfs to complete, and
results are g¡ven to you at the testing center immedlatelyafter you finlsh.

Adobe recertlñcat¡on exams are Web administered exams that are a,/á¡lable to
current ACES only. The exams áre delivered to your de5ktop via the Web. The tests
com¡st of 30-60 multiple choke quentons, Eadr exam takes approx¡mately 30 to
60 m¡nutes to complete, Results are revealed immediátely onl¡ne after you finish.

SÍEP a: sfgn th. ACE A9rc.m.nt lnd roln th. Adob. Ccrtfl.d (ommuñlty

ReviewtheACE Agréement pr¡orto taking theexam. You w¡ll be asked to agree
to the ACE terms and condit¡ons at the time ofthe exam.

Once you are ACE certifred,v¡sit the Adobe Cenified community where you can:

. Verify exam re6ults

. Get a copy ofth€ ACE Agreement

. Download your Adobe Certiñed logo

. Find out about recertiñcation

. Connect with other Adobe certificants

. Updateyour proñle

Note: lnformot¡on about úe Adobe Grt¡ñed Commun¡ty ¡s also pt¡nted on your
scote repott,

nc(crtlfy whan ¡€(es5.ry
Once obtained, your ACE certificat¡on ¡svalid unt¡l90 days after the exam
version ofyour c€rtiñcatlon is retired. Adobe will e-mailyou a reminder when
your certiñcation ¡s duefor renewaland willletyou know when you need to take
the recert¡ñ<ation exam-

/r\'
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ADOBE PHOTOSHOP CS2

Adobe" Photoshop cs2

AfE ExAM

TOPIC AREAS

oiuo
OBJECTIVES

AcE Exrm Cont nt: Toplc l¡.!s .nd Obractly.t
Following is a detailed oud¡ne of the ¡nformatlon co\€r€d on the ACE Exam,

r. wofklog w¡th the Pñotoshop Ul

. Descr¡be the advantages of saving workspaces.

. G¡ven a v¡ew in Adobe Bridgq expla¡n when you would ure that view'

. Descr¡be the bas¡c funct¡onal¡ty prov¡ded by the Preset Manaqer,and
explain how to use the Preset Manager to manage l¡braries.

. Custom¡ze menus and keyboard shoncuts by selectlng options ¡n the
Keyboard Shoncuts and Menus dialog box.

2. Palntlng and r.touchlng

. G¡ven a tool. paintan object by using that tool (foob ¡nclude:8rush fool,
PencllTooL Eraser).

. G¡ven a tool, retouch an imág€ by using that toolffools ¡nclude: Healing

Brush, Patch Tool, Color Replacement Tool, Red Eye tool).

. Adjust the tonal range ofan image by selecting to prop€r optioos and us¡ng

a leveb adjustmem layer.

. Adjust the tonal range ofan ¡mage by selecting the proper options and
using a curves adjustment layer.

. Expla¡n how blend¡ng modes are used to controlhow pixeh are effected
when us¡ng a palnting oreditlng tool.

. Create and use pattems.

. Create and use gradients.

. Given a sett¡ng inthe E¡posure dialog box, explaln how that setting affects
an image.

. Create and edit a custom brush.

t, Cra.tlng and using l.y.rs
. Create and arfange layers and groups.

. Explain the purpose oflayercompsand when you would usea layer comp.

. Explain how orwhy you would u5ea cl¡pp¡ng group.

. Explain how orwhyyou would usea layer mask.

. Create and save a l4/er style.

. Select and work w¡th mult¡ple layers ¡n an ¡mage.

. Given a s(enario, edit layer properties.

. Cr€ate and use Smart obiects.

a. Worklng wlth ¡.lectlons

. Create and modify selectlons by u5ing the appfopr¡ate sele<tion tool.

. Sa\re and load select¡ons.

Page 6
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ATE EXAM

TpPrC AREAs

AND

OBJECTIVES

5.

6.

7.

a.

9.

ro.

11,

ADOBE PHOÍOSHOP CS2

Explain how to createand modify a temporary maskby us¡ng the Quick
mask command.

Create and modlfy select¡ons by using the Channels palette.

Supeonlng Yld.o

Explaln the purpose ofVldeo Preview.

Describe the purpos€ of pixel aspect ratlo cored¡on,

Undcrstrndlng ñL p?opertl6

Glven a scenarlo, select the appropriate color modeforan lmage (S<enarios

lncludefor web, for vldeo, br Pr¡nt).

Add metadáta for an lmage in Adob€ Photoshop.

Explatn thefunctionality prov¡ded by High Dynamic Range (HDR)¡maqes

and describe the workflow for HDR ñles.

Expla¡n the advantages of work¡ng with i6-b¡t lmages versus 8-b¡t imag€s,

Workln¡ wlth Y.Ctor tool3

Create shape layers and paths byus¡ngthe Pen and Shapetools.

Explain the advantages of us¡ng vector drdwing toob versus us¡ng rater
drawing tools.

G¡ven a sceriar¡o, alter the prop€ni$ oftype.

Create and edlt p¿ths by us¡ng the Paths pal€tte.

Wortlng wlth.utormtlon

Create and use actions.

Createand use batches,

L¡st and descrlbe the autoñat¡on leatures avallable ln Adob€ Photoshop.

Descr¡be the d¡fference between scriptlng and ¡ctlons and when you would
use one ov€r the othef.

Workln9 wlth ñltGrt

G¡ven a scenar¡o, select the appropriate sett¡ngs and use the Reduce No¡se

ñlter.

G¡ven a scenario, select the appropr¡ate se,ttings and us€ the Sman Sharpen
ñlter.

D€s«¡be the functionallty of the Filter Gallery.

¡ltn gtng .$at5 rlth Bddgc

Llst and descrlbe the functlonal¡tyAdobe Bridge provld€s for vlewing assets.

Explain how to apply metadata and keywords to asrets in Adobe Brldge,

L¡stand descr¡be the functionality and set the appropriate opt¡ons for
Camera RAW preferences, and the Apply Camera RAW Settings menu
optlons.

Uslng C!m.r. RAW

Describe advantages of the RAW camera format,

G¡ven an adjustment sett¡ng, explain the purpose of that setting.

Expla¡n the purpos€ ofand funct¡onallty provided by the Open, Save, and

/r\'
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ATE EXAM

rf*c o*rot
Al¡D
OBJECTIVES

t2.

11.

r+

ADOBE PHOÍOSHOP CS2

Done buttonr ¡n the Camera RAW dialog box.

Describe howto usethe D¡g¡tal Negat¡ve converterand expla¡n the
importance ofthe DNG fofm¿t.

Outputtlng to pdnt

G¡ven a color handl¡ng method in the Printwith Preüew dialog bo& explain
when you would use that method.

Given a scen¿fio, selectand explain when to use a rpecifrc Print command
(Prlnt commands in€lude: Pr¡nt One Copy, Prim Prev¡ew Pr¡nt).

Expla¡n the d¡fferences between monitor, images, and device resolution,

l¡lanaglng colof

Di5cusr the color management workflow process that ¡5 used ¡n Adob€
Photoshop (fop¡cs ¡nclude: ICC proñles, color management eng¡n€, color
numbers),

Descr¡be the d¡fference between a§slgning añd convening to lcc profiles.

Configure color sett¡ngs by using the ColorSeüings dialog box.

Expla¡n the purpose ofand how to usethe ProofSetup command.

Discuss the relationsh¡p between colorqamut and rendering ¡ntents.

Prap.rlnt .nd outputthg inrgrs lor thc W.b

Giveo a scénar¡o, choose the appropriate file format to optim¡z€ images for
the wéb.

Create transparent and matted ¡mages by us¡ng the Save for web command,

Expla¡n the purpose ofand how to useVariables.

Expla¡n how sl¡ces can be used to optimize images for the Web (Options

include: la),er based, user based, l¡nk¡ng sl¡ces for opt¡mizat¡on).

Explain the use of laye.s when creating an animation in Photoshop.

/r\'
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RFCERTTFTCATTON

EIAM ToPrC

AFEAs AND

OBJECTIVES

ADOBE PHOTOSHOP CS2

R.ccrtlñ(.üon Erlm content: lopl. Ar..r rnd obJ.<tives

Follow¡ng ¡s a detáiled outline of the infomation co\ered on the receniñcat¡on exam.

i. Work¡ng wlth th. Photo3hop Ul

. Describe the advantages of workpace presets.

. G¡ven a vlew in Adobe Br¡dge,explain when you would use th¿t view.

. Customlze menus byselect¡ng options ¡n the Menus d¡alog box.

2. Pr¡nting and rstou(hlng

. Given a tool, retouch an ¡mage by us¡ng th€ Red Eyetoolorthe Spot Healing brush.

. Given a setting in the Exposure dialog box,explain how thatsett¡ng affects an ¡mage.

,. Craaüng and uJlng hyar¡

. Selectand work with multiple layers in an image.

. Create and use Sman objects.

a. Supportlngüd.o

. Explain the purpose ofvldeo Preview

5. Undcfn.ndlng ñ1. prop.rtl.r
. Expla¡n the functional¡ty provided by High Dynamic Range (HDR) ¡mages and descr¡be

the workflow for HDR frles.

ó. Workirg wlth .utomatlon

. Create an HDR ¡mage by us¡ng the Merge to HOR command.

7. wofking w¡th flt fs

. Glven a scenario, select the appropriate sett¡ngs and use the Reduce Nolse6lter.

. G¡ven a scenar¡o, selectthe approprlate settings and use the Sman Sharpen filter.

. Given a scenado, select the appropr¡ate sett¡ngs and use the Vanlsh¡ng Point ñlter.

. Given a scenarlo, select the appropr¡ate sett¡ngs and usethe Lens Cofrection ñlter.

8. M.náglng ürolr uhh Brldge

. List and descr¡bethe funct¡onal¡ty Adobe Bridge prov¡des for vlew¡ng as5et5-

. Explain howtoapply metadata and keywords to assets ¡n Adobe Brldge.

. List and describe the funct¡onality and set the appropr¡ate optlons forCamera RAW
preferences, and the Apply Camera RAW Settings menu opt¡ons.

9. Uslng crmer. RAW

. Expla¡n the purpore of and funct¡onality prov¡ded by the open, Save, and Done buttons
¡n the camera RAW d¡alog box.

. Describe how to usethe Digital Negat¡ve <onverter and expl.¡n the ¡mportance ofthe
DNG format.

ro. Outputtlng to pr¡nt

. G¡ven a color handling method ¡nthe Print with Previewdialog box, expla¡n when you

would use that method.

1.t. Pr.paring and Outputtlng lñag.i for thc W¡b

. Expla¡n the purposeofand how to usevariables.

. Explaln the use of layers when creating an an¡mation in Pñotoshop.

/r\'
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i¿, Worklñg wlth PDF do0m.nts

' Given a scenar¡o, selÉct the appropriate opt¡ons to open, place, or save a PDF do€ument
in Photoshop.

. Manage PDF presets by choosing the Adob€ PDF Preset command.

ADOBE PHOTOSHOP CS2

/r\'
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ADOBE PHOTOSHOP CS2

PRACTICE EXAM

Try out these helpful pract¡ce

quest¡ons to get a feel for the
types ofquest¡ons on the ACE

and recert¡llcatlon exams,

but please note thatyour
perforrn¿ nce here does not
ind¡cate how you'lldo on the
actual exam. To fully prepare

for the exam, clos€ly review the
topic areas and obiecti\res ¡nth¡s

9uide.

I D.rcrlb. th. b.dc ft¡ncüonallty proüd.d by th. Pr€5.t li.¡rgar, rnd
.rolrln how to ur€ tñc Prosat M¡nrgar to m¡n¡gc llbtarlé!.
You have downloaded a new brushes library to your d€sktop. You want to use
thir library. What rhouldyou do?

A. choose the new brushes library from the bottom ofthe Preset Manager
palette menu

B. open the Preset Manager, then choose Edit > Deñne Brush Preset , , , and

choose the new brushes library

C, restart Photoshop and choose the new brushes l¡brary from the Preset Type
menu in the Preset Mánager

D. open the Preset Manager, click the Load button, and double-cl¡ck the new

brushes library¡n the Load dialog box

Corect Answer: D

2. Glycn. tool, p.lnt rn obiect by u3lng thrt tool.
You are using the Bfush tool as an Airbrush. What happens ifyou continuously
hold down the mouse button w¡th the tooloverthe ¡mage without movlng the
mouSe?

A. The foreground color builds up in the area around the Airbrush

8. The foreground color l¡ghtly spra)rs onto the area around the A¡rbrush

C. No color i5 applied unt¡lyou move the Airbrush tool, and then the
foreground color is appl¡ed

D. No color is applied until you move the Airbrush tool, and then the
background color ¡s appl¡ed

Correct Answer: A

3. Adrust the tonll rlnge of rn im¡ga by 3alact¡ng to prop.r optlons rnd
u3lng a larclr ldjustmant layar.

You want to mod¡fythe ton¿lrange ofan imagewithout permanently añecting
the pixels. what should you do?

A. useVadations

B. use Auto Le\r'els

C. usea layer style

D. use an adjustment layer

Corect Answer: D

4. crcate sñd ura páttarn5.

You are using the Fattem Stamptoolto pa¡nt inyour ¡mage. Which tooloption
ensures that the pattern is applied continuously, ratherthan from the in¡tial

sampling point, regardless of how marryt¡mes you stop and resume pa¡nt¡ng

w¡th the pattern?

A. Flow /r\'
Page 11 ldoi.
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PRACTICE EXAM

ADOBE PHOTOSHOP CS2

8. Allgned

C. lmpressionist

D, Protect Texture

Cored Answer: B

5. Crartc and ula grrdloñts.

You are drawing a gradient on a layer in your ¡mage, and you want to create a

smoother blend with less bandlng. What should you do?

A, create an angle gr¿dient

B, reduce the opachy ofthe layer

C, sel€ct Dlther from the options bar

D. select Transparency from the opt¡om bar

Corect Answef: C

6. C.litc and ¡d¡t | (uitom brurh.

Which statementabout custom brushes is true?

A, All custom brushes are deleted when you close Photoshop,

B. Th€ b.ush t¡p6 ¡n a du¿l brush are always the same, but you can varytheir
d¡ametefs.

C. Custom brushes created from the Brushes palette are automat¡cally 5a\€d to
the default brush library.

D. New custom brushes can be created from the palette rnenus in both the
Opt¡ons bar and the Brushes palette,

Cofrect Answen D

7. Expltln ths purpocc of lay$ rompt and whln you uould ure a ley:r romp.
when should you use a láyer comp?

A. to nést a layer group in another layer group

B. to apply mult¡ple adjurtment la)rers to a single ¡mage

C. to (reate a clipp¡ng mask that affects multiple layouts

D. toorgan¡ze multlple versions ofa layout in a single image

Correct Ansv\€r: D

8, Exphln how or why yoü liould usa ¡ hror mark.

The active layer of a document has a hyer mask. You want to select the pon¡on
ofthe layer that ¡i v¡sible,What should you do?

A. use the Mag¡c Wand and cl¡d on the transparent part of the layer

B. Ctrl (windows) or Command (Mac OS) cl¡ck on the layer ma5k thumbnail ¡n

the Layers palette

C. use the Select > Load Select¡on command and choose the la)rels
transparency with lnvert checked

D. use the Select > Load Selection command and choose the laye/s
transparency w¡th lm/en unchecked

Conect Answer: B

/r\'
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PRACTICE EXAM

ADOBE PHOTOSHOP CS2

9. ErDldn how or wlty you xould usa a layar m.3k
You want to hide pon¡ons of an ¡mage on one layef, and you want to have soft
edges afound the üsible portlon so that it blends wi¡h the lo/er undemeath ¡t.
Whatshould you do?

A. add a layermask

B. add a vector mask

C. add a cl¡pp¡ng mask

D. add an adjustmem layer

Correct AnSwef: A

ro. Cr.ata rnd saYa r l¡yar ttyla.
What should you do to create a layerstyle that includes a b€veled edge and
makes the orig¡nal content of the layer tránsparent?

A. set the layer's Fill Opacity to 096, thén when savlng the style, select Include

Layer Blend¡ng Options

8. set the laye/s Fill Opac¡ty to o%, then when saving the style, deselect
lnclude Layer Blending Options

C. set the layer's master opacity to o%, then when saving the style, select

lnclude Layer Blending Options

D. set the laye/s master Opacity to o%, then when savlng the style, deselect
lnclude Layer Blending Opt¡on§

Corect Answer: A

r.r. Sclact and wort wlth multlph lrltrr ln ¡n lmlga,
what happens when you choose the command Layer > Flatten ¡mag€?

A. Layers withln layer groups are merged ¡nto a single layer.

B. All layers are made vlsible and then combined ¡nto ttre background layer.

C. The att¡ye layer and allvisible layers belolv ¡t are combined ¡nto a single
layer.

D. All v¡sible layers are combined lnto the background layer and hldden layers

are disc¡rded.

CorectAnswef: D

rr. Sal,e<t ard work yith ñült¡pla layef3 ln rn lm¡gc.
How do you hlde the content ofseveral layer groups yvith one mask?

A. put allofthe layer groups ¡ñs¡de a new layer group, select this new set, then
click the Add Mask button

B. create a cl¡pping mask consisting of the la),er groups, select the base set in
thar group, ¿nd click the Add Mask buton

C, <reate a layer above the lay€r groupi, set hs F¡ll Opacity to o%, and its
Knockout setting to Deep

D. create a l¿yer above the layer groups, set its Fill Opacity to o , and its
Knockout sett¡ng to Shallow

Co.rect Ansurer: A

Page 13
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PRACTICE EXAM

ADOBE PHOTOSHOP CS2

íf. Cre¡t .nd u$c Smart objrct!.
You have placed an Adobe lllustrator Smart Object into your Photoshop file.
How shou¡d ),ou a€t¡vate the Srnart Object 50 ¡t can be edlted ln lllustrator?

A. double-clickthe¡mage

B. cho6e Layer > Smart Objects > Redace Contents

c. double-(lick the Smart Obiect thumbna¡l ln the Layers palefte

D. right-cllck (Windows) or Conrol-cl¡ck the Sman Object thumbnail ¡n the
Layers palette and choose Replace contents from thé context menu

Correct Answer: C

rG Crr.tc.nd modlfy salectlons by u3lng tll. appropd.t r.L<tlon tool
You have created a select¡on ofan object that you want to use in another area

of your ¡mage. You want to soften the edges ofthe relected object 50 that it will
blend ¡n with the background. what should you do?

A. feather the selection

B. smooth the seléctioo

C. anti-alias the selection

D. apply a Gaussian Blur to the sel€ction

Cofrect Answer: A

rj. §.Ya 6nd load SClectlons.

You have made and saved a selection as an alpha channel. You máke another
selection that overlaps a ponlon of th€ alpha channel selection you s¿ved. You

want a selection of only theoverlapp¡n9 region. what should you do?

A. choose Select > Load Selection, choose the overlapping álpha channel, and
select Add to Sehctlon

B. hold down the shift key while Ctrl (Wndows) or Command (Mac 05) clicking
on tlle overlapping alpha channel

C, choore Select > Load Select¡on, choose the overlapp¡ng alpha ch¿nnel, and

select lntersect wlth select¡on

D. click the lntersect with Selection button ¡n the Opt¡ons Bar, then Ctrl
(windows) orcommand (MacoS) dick on the overlapping alpha channel

Corect Answer: C

/r\'
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PRACTICE EXAM

ADOBE PHOTOSHOP CS2

rú. Erelrln how to c..rt lnd modlfrr t.mpofáry mr¡k by u¡lng tha Qulck
ma¡kcomm!nd,
You ha\re created a rough selcct¡on of án object in your ¡mage. You want to
refinethe selection by uslng quick maskwith ¡ts default settings and th€ Erush

tool. Whidr staterient is true?

A. Painting wlth wh¡te adds to the relection.

8. Paint¡ng with black adds to the select¡on.

C. The opacitysett¡ng ofthé brush is lrrelevant.

D. The foregrouñd color must be either black or white.

Correct Answer: A

rz Dercrlba tha pürpo3a of plxal arpact rrt¡o corra<tloñ.

Which tatement ábour P¡xel Aspect Ratio Correction ¡s true?

A. Non-squafe plxel documents open wlth Plx€l Aspect Ratlo Correct¡on

tumed off by default.

B. Non-square pixeldocuments open w¡th PlxelAspe« Rat¡o Corection
turned on by default.

C. Turnlng on Pixel Aspect Ratio Correctbn allows you to se€ a squaré pixel

¡mage a5 it wlll appear on a computer monitor.

D. Tum¡ng on Pb(el Asped Ratio Cofrection allows you to see a nori-square
pixel¡mage as ¡twlllappearon a computer monltor.

Corfect Ans!¡ven B

18. Dascrlba tho purposa of p¡xal rspact ratio corra<tlon.

You are creatlng a graph¡c th¿t ¡s to be used in an Anamorphic (2:r) v¡deo
product. You use the Ellipse toolwh¡le holding down the shift key. PixelAsp€ct
Ratio Correction prev¡ew ls d¡s¿bled. How does the resultappearin Photoshop?

A. a c¡rcle with p¡xels twice as tall as they are wide

B. a circle w¡th p¡xels twice as wide as they are táll

C, an ellipse twice as tall as it ¡5 w¡de w¡th square pi)(els

O, an ell¡pse tw¡cé as w¡de as it ¡s tallwith square p¡xels

Correct Answsr: C

,r9. Cr..t sh.p. l.ycB .nd p¡ths by u3ln9 thc Per rnd Sh.pa tooB.
You have drawn a vector based ellipse w¡th the Ellipse tool. What :hould you do
to change the ñll color of the elllpse, wh¡le keeping theellipGe a \r€ctor shape?

A. drag a new color from the Swatches palette to the ¡nterior ofthe ell¡pse

B. cl¡ck the ellip6e wlth the Path tool, and select the new color from the
swatches palette

C. drag a pa¡nt brush oyer the ellipEe after selecting the new color from the
Swatcher palette

D. double-click the La)rer thumbnail in the elllpse! Layers pahtte, then click a

new color ln the swatches palette

Coréct AnsweÍ D
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PRACTICE EXAM

ADOBE PHOTOSHOP CS2

20. Gly.n . scenülo, llt r thG prop€rtlG3 oltypa.
You wantto changethe default Auto Leadlng perc€ntage for type. What should
you do?

A. choose ,u5ti6cation from the Character p¿lette menu

B. choose Justifcation from the Pafagraph palette menu

C. choose the percenbge from the Leading menu ofthe Character palette

D. choose the percentage frorn the Lead¡ng menu of the Paragraph palette

Conect Answef: B

2t. lxphln the pu.polr of rnd lunctlomllty proyld.d by th. Opcn, 9.yo, rñd
Dona buf.tons ln tñc C.meru RAW dl.log box.

You are proc€rsing a Camera Raw lmage using the Adobe Camera Raw dialog
box. You want to qu¡ckly create multiple vers¡ons ofth¡s document, each ryith
d¡fferent settlng5applled and each with a un¡que name.what should you do?

A. configure the settings, then click Save to name the document and specify a
6le format

B. conñgure the settings, then click Open to name the docuñent and spec¡fy a

frle format

C. conltgure the settings, then dick Alt-click (Windows) or Option-Click (Ma(

OS) Save to namethe documentand speclfy a fle format

D. confrqure the settings, then click Alt-cl¡ck (windows) or Opt¡on-Click (Mac

OS) Open to namethedocument and spec¡ry a ñléformat

Conect Answer: A

¡r. GlvGn a ¡ranrrlo, saLct and axpLln whan to uic r 3pcdllc P.lnt commrnd,

You want to specify a halftone screen frequency when you pr¡nt your lmage.

which command should you choose to access thls option?

A. F¡le > Print

B. File > Page Setup

C. File > Print OneCopy

D. File > Print wlth Preview

corect Answer: D

:r. D¡r(u53 th¡ colo. managclmnt uo.kflow proclts thlt B urad l¡ lt obc
Photorhop.

A photograph was scanned on two sc¿nners, each of whkh has a val¡d ICC

profilethat has been assigned tothe scans. Whlch statement Is true?

A, The (olors in each document look different, but the color numbefs are
¡dentical,

B- The colo6 ln each document look different and the color numbeB are

different.

C, Th€ colo6 in each document look the same, btrt the color numbeE are

different,

D. The coloB in each docu[rent look the same and the color numbers are

identical.

/r\'
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,4. D.sdb. th. dlfcr¡ntc bffie¡r ¡¡tlgnlng rnd cony.rtlng to lcc proñLt.
You wamtotag a documentwlth a differént color proñle w¡thoutchanging the colors to the
netv profile space. What should you do?

A. choose Edit > Assign Pro6le

B. choose Edlt > Convert to Proñle

C. choore Edit > Color settings, and seléct á new wori(lng space

D, choosc view > Proof Setup, and choose the proñle ftom the llst

Correct Ariswer: A

15. Explaln tha pürposa ol ind how to uie tha Ptoof satup comÍ¡¡nd.

What does Proof S€tup do?

A, lt configures the optlons (crop rnarks, bleed, etc) for the device on which you
produce prooB.

8. lt configures optlons for preüewing on your monitor wh¿t colors a proñled device

will produce.

C. lt configurÉs the optlons (crop rnarks, bleed, etc) for the dev¡cé on wh¡ch you

typlcally print work.

D. lt confrgures options (compression, resampllng, etc) for produ<¡ng a PDF "proof'
of thé document.

Cofrect Anrlven B

26. Olscurs the rolrt¡onshtp batween color gamut and .andcrlng iDtants.

You are convert¡ng a document from one large gamut pro6le to another. You are most
concemed about preserv¡ng the colors and maximizing the tonal range with¡n the
destlnation gamut, which rendering intent should you use?

A, Saturation

B, Perc€ptual

C. RelativeColorimetric

D. AbsohrteColorimetric

CorrectAnswer: C

¿7. Glvcn a 3aenarlo, choo3a tha app.opritte ñla formrt to opllm¡ra tmag.s for tha WGb,

whlch ñl€ format should you use to display photographs and other continuous-tone images

on the Web?

A. GIF

B. TIFF

C. PDF

D. JPEG

Corect Answef: o

¡8. Crsát trrnspafant ¡rd Erttad lmagús by uslng tha g¡va for Wab cotnmrnd,

ln the GIF optlmizat¡on seüings, whatshould you doto make allpixels w¡th greater than 5096

transparency fully transparent and ¿llpixels wlth 5096 or less transparency fully opaque?

A, select Transparency and choose None from the Matte menu

B. deselect Trañsparency and choose None from the Matte menu

C. select Transparency and choose a Matte color from the Matte menu

D. deselect Transparency and choose a matte color from the Matte menu

correct Ans\ryef: A

/r\'
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¡t. Erplalñ the purposc ofrnd how to usaVarlrbl€3.

ln a template for a data-dr¡ven graphic, when should you specify the replacement ¡mage for
a Plxel ReplacÉmem variable?

A. when you deñne a data set

8. when you n¿nre the variable

C. when you choose the varlable type

O. when you specify P¡xel Replacement opt¡ons

Corect Ans\,ver: A

!o. Expl¡¡n how sllc.3 san bG u3ad to opt¡ñlta lmrglr for tl¡e wcb.

You have a s¡ngle hyef€d docum€nt. You want to generate a JFEG ofa smallarea of the
do(ument. What should )rou do?

A. Copy that area to a new layer, d¡sable the vislb¡lhy of the orig¡nal lryer, then use the Save

for Web dialog box

B. Save a selection ofthat area as a channel, then d¡ckthe Alpha channelbutton ¡n the Sá,/e

for Web dialog box

C, Create a sl¡ce ofthat area, then choose AllUser Slice5 from the Sl¡ce5 pop-up menu ofthe
Save Optim¡zed As d¡alog box

D. Create a marquee of that area, theñ choose All User Slices ftom the Slices pop-up menu

ofthe Save Opt¡mized As d¡alog box

Cofrect Answef: C

3r. Explah thc u'. of Lyaf3 r'ñan clratlng an an¡rn¡üon ln Photothop.

After creatlng an anlmatlon, you dec¡dethat you want to modifythe Layer Style you used

on one of the layers ¡n th€ an¡mat¡on, You want tlle (hange to affect every frame ln the
animat¡on.What should you do?

A, select all ofthe fram€s ¡n the An¡mation palette and ed¡t the Layer style

B, select the layer in the Layers palette, edit the Layer Style and then select Unify L¿yer

Style

C. select Frame 1, edlt the Layer S§de and select Propagate Frame 1 from the La)rers paleüe

D. select the 6rst and last frames, edlt the Layer Style, and choose Tween from the
Animation palette

Correct Answer: B
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